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Benefits of Registration

+ You receive the most current version of WordExpress with your order.

+ Printed manual, master disks, and free technical support

+ Significantly enhanced Spell Check in the language of your choice 

+ Full featured Thesaurus, and Automatic Hyphenation

+ 25 great templates to make using WordExpress easier and more productive

+ Special offers and big discounts on other MicroVision products

+ Removal of all evaluation notices on printed documents

+ No more registration request screens

+ You're supporting the shareware concept

+ Thank you!



Evaluation Period

This is an evaluation copy of WordExpress.    The Evaluation Period runs for 30 days starting with your 
first day of use.    During this time we provide you with full access to all the functionality of WordExpress.    
We welcome this opportunity to introduce you to the capabilities of our software, and for you to determine 
if it fits your needs. 

WordExpress is not Freeware however, and at the end of the Evaluation Period you are expected and 
required to purchase the Registered Version, if you plan to continue using WordExpress. 

Once the Evaluation Period has expired the program will become a true evaluation copy.    All printed 
documents will then carry markings denoting that they were printed with the evaluation copy.    We will of 
course warn you that this will happen each time before you print.

Thank you again for taking the time to evaluate WordExpress.
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ASCII
ASCII stands for the American Standard Code for Information Interchange. It defines the basic alphabetic 
characters used on the PC. ASCII can be used to exchange data with virtually any DOS based PC 
however it does not allow you to exchange formatting characters such as bold, underline etc. or use 
different fonts. For this reason it tends to only be used when no other method for exchanging files is 
available.



ANSI
ANSI is the American National Standards Institute. It defines standards such as the character sets used 
by PCs and many other things. ANSI also defined the character set used by Windows. In WordExpress 
we use the phrase ANSI to refer to the Windows character set whereas we use the word ASCII to refer to 
the older DOS based character set.



Byte
Bytes are the basic unit of measurement when referring to data storage. A single byte is equal to one 
character of disk space. Bytes can also be measured as kilobytes and megabytes. 

Note: The number of bytes in a WordExpress document is likely to be larger than the number of 
characters because spaces also take up disk storage space.



Winword
Winword is the shortened form of the name Word for Windows. Word for Windows is a word processing 
program developed by Microsoft. WordExpress can exchange data with Winword by saving a file as a 
Word file format or an RTF file format. WordExpress can read files created with Word for Windows 2.0 
and 6.0.



CSV
CSV is Comma Separated Value text files. A CSV file is a very simple file in which data is separated by 
commas and surrounded by quotation marks. This type of file is used for mail merge. The "Hints and Tips" 
section of this help file discusses how to use these files in more detail.



dBase
dBase is a database program developed originally by Ashton-Tate and now owned by Borland. Because it 
was one of the first useful database programs the file format was copied by many applications and 
WordExpress can read data files produced by dBase III and dBase IV. 

dBase files normally have the file extension "dbf" and are sometimes referred to as dbf files.



HLP
HLP is the file extension used for Windows Help Files.



TOC
TOC is the abbreviation used for Table of Contents.



Hotspot
In the context of Windows help files a "hotspot" is a point on a graphic or text which causes you to pop-up 
a new piece of help information or jump to another piece of information.



BMP
A BMP is the general term used for graphical Windows bitmap files. BMP files can be included as 
graphics in WordExpress documents. 



Dialog
A dialog or dialog box is a general term used for the boxes that pop-up during Windows operations. 
Typically a dialog might ask you to click on "OK" or "Cancel". More complex dialogs might involve you 
choosing a file from a list (for example). 



Common Dialog
A Common Dialog is a standard dialog box supplied by Windows. Common Dialogs allow WordExpress to 
react in a similar way to other Windows programs and thus minimize the learning curve when you move 
between applications.

A typical Common Dialog is the box displayed when you open an existing file.



OLE
OLE stands for Object Linking and Embedding. This is a technique where an "object" is placed in a 
WordExpress document that is created or updated by another program. OLE has gone through two major 
revisions called OLE 1.0 and OLE 2.0. WordExpress supports OLE 2.0. 

To work OLE requires that one application be a client and one be a server. The server supplies the object 
and the client is able to embed it. Typical applications include placing a graphic into WordExpress as an 
object. The graphic can then be opened by the original application by double clicking on it.



MAPI
MAPI is the protocol used by Microsoft Mail. A program that understands MAPI can send a document to 
Microsoft Mail. In the past MAPI has mainly been used on computers with networks to send email 
between network users. However MAPI also has a FAX component, used in Windows 95, and therefore 
being able to "Send Mail" also has relevance to PCs with a FAX modem.



Template
A template is a special WordExpress document. In fact it is a document that you can base other 
documents on. All WordExpress templates are held in the template directory. When you select File | New 
WordExpress will automatically use the "normal" template to base the current document on unless you 
change the default.

The template contains the page size and any default layouts you might have prepared. 



Directory
A directory is a listing of files on a computers hard disk or the place on the hard disk where a listing of 
files is located. Typically your hard disk is divided up into directories so that files can be stored under 
logically named categories in the same way a conventional filing system places files in alphabetical order.

In Windows the directories appear as icons that look like folders. Hence for all practical purposes on a 
Windows based PC the word "folder" and "directory" can be treated as the same.



Folder
A folder is part of a Windows based PC filing system. A folder is a storage location on a PC in the same 
sense as a folder in a filing cabinet is a storage location. Folders all have names. In the context of 
WordExpress a folder called LETTERS might have all the letters you have written using WordExpress. 
You should create folders for the general categories of document you create so that your computer's filing 
system is easy to manage.

Folders are also known as directories on older non-Windows PCs.



HTML
HTML is the HyperText Markup Language. It is the language used to develop web pages on the Internet. 
WordExpress can read and convert HTML files that you have downloaded from the Internet into other 
kinds of files.

Note: At this time you cannot create HTML files directly with WordExpress. HTML files created or saved 
on Windows based PCs have the file extension HTM.



File Extension
File extensions are used on Windows based PCs to tell programs the type of data the file contains. For 
example the file extension TXT is associated with plain text ASCII files.

The file extensions used by WordExpress version 2.0 are WD2 for documents and WT2 for templates. 



File Name
Each WordExpress document you save must have a file name so that it can be stored on disk. The name 
of a file in WordExpress has three components. The name you choose, a period and then a file extension. 
For WordExpress documents the extension is WD2 and for templates WT2. If you don't tell WordExpress 
the file extension it will add it automatically. The period "." is used in the file name simply to separate the 
name portion from the extension. 

In Windows 95 file names may have 256 characters. 

Note: You should only use alphabetic characters A to Z or a to z and numbers 0 to 9 for file names. The 
256 character file names used by Windows 95 can use spaces too.



Access
If you use the Microsoft Access database you can use the data to write personalized letters with 
WordExpress. However you will need to export your data into a CSV (Comma Separated Value) file or a 
dBase compatible file.

Please refer to the Microsoft documentation for details as to how to do this.



Approach
You can use Lotus Approach databases to create personalized letters with WordExpress. However you 
will have to export the Lotus Approach data as a CSV (Comma Separated Value) file or a dBase file. 

Please see the Lotus Approach documentation for full details. 



Internet Support
WordExpress can read World Wide Web pages downloaded from the Internet. Web pages are normally 
written using a format called HTML. You can open files with the extension HTM directly from 
WordExpress. Simply use FILE | OPEN like any other document type.



Filter
A filter is simply a conversion tool supplied with WordExpress. Filters are able to read files written by other 
word processors and even Internet web pages. You don't actually have to run any special programs to 
convert a file simply do a FILE | OPEN to open a file and select the type of file you want to read. When 
you want to save a file using a filter then do a FILE | SAVE AS.

If you don't use a filter WordExpress expects files to be in it's own format.



Bookmark
A bookmark in a word processor is similar to a real bookmark. If you want to locate a point in your 
document quickly then the easiest way is bookmark your current position. Later on you can jump back to 
the bookmark.

Bookmarks are fully supported in WordExpress.



RTF
RTF means Rich Text Format. RTF is a file format that is independent of a specific Word Processor but 
many word processors can read and write the format. It is an improvement over ASCII because it saves 
information about effects such as bold, underline etc. It also includes font information.

Due to the range of word processors that support RTF it is gradually becoming a way that information is 
transferred between different programs.



Typeface
Many people confuse the a typeface with a font. The confusion has become all the more acute with the 
popularity of TrueType Fonts in Microsoft Windows. 

In essence a typeface is the style of characters. For example Times. 



Font
Many people confuse a font with a typeface. A font is a particular typeface of a particular size of a 
particular weight. So Ariel, 12 point, bold is a different font to Ariel, 10 point, regular. Ariel itself is a 
different typeface to Times Roman.



Points
Points have been used for many years by printers and typesetters to define the size of particular 
characters. You can use the point measuring system to work out the exact height of characters on a page. 
There are 72 points to 1 inch.



Proportional Fonts
Proportional Fonts are fonts whose letters vary width in proportion to their height. Examples include Ariel, 
System and Times Roman. Courier is a non-proportional font.

The significance of this is that if you import from another word processor a document with tables you may 
find they are not lined up properly. This is because the other word processor used a proportional font and 
you haven't imported it's column definition. A quick fix is to select the text and turn it into courier.



WordPerfect
WordExpress comes with a WordPerfect filter and it can read/write WordPerfect documents. 



New Features
See the topic "Introducing WordExpress" for full details about this new version.



Objects
The word "object" is used in two different senses by WordExpress. 

Object mode is used to illustrate the difference between typing text in "text mode" and placing graphics or 
text boxes into your document. 

Objects as a generic term in Windows is used to refer to OLE (Object Linking and Embedding). 

In WordExpress the word "object" can be used in both ways. The context should make it's use clear on 
each occasion. 



Document
A document, in the context of WordExpress, means a WordExpress document. Other word processors 
may also refer to "documents" meaning their own files or specifically DOC files. 

A DOC file in Windows is usually a file produced by Word for Windows. It gets this name from the file 
extension DOC that it uses when it saves files. DOC files should not be confused with the general word 
document.



ZIP
The word ZIP is worth mentioning because of the two meanings you may come across while using 
WordExpress. 

A ZIP file is a file that has been compressed with PKZIP. In order for such a file to be useful it has to be 
decompressed using another program. It is common for people using modem links to send large 
documents compressed to save phone charges. It is beyond the scope of this help file to discuss 
compressed files but you may have occasion to receive compressed documents.

ZIP also refers to the postal code system in the USA. Outside the United States ZIP codes are referred to 
as postal codes.



Centimeter
The centimeter is a common form of measurement used to measure paper sizes in countries where the 
metric system is the norm. There are 2.54 centimeters to 1 inch.

Note: WordExpress will obey metric measurements if your PC is set correctly to a non-US country in the 
Windows Control Panel and you have chosen non-US paper sizes. 



A4
A4 is one of many ISO standard paper sizes. ISO standard paper is used in countries outside the USA. 
WordExpress fully supports ISO paper sizes if your page settings and printer settings are altered to do so.



Letter
Letter, or perhaps more precisely US Letter, is the standard stationery size used in the USA. Outside the 
USA the nearest equivalent standard is A4. 



ISO
The ISO is the International Standards Institute. National standards organizations like ANSI in the USA 
and the BSI in the United Kingdom are affiliated to the ISO. 

In the context of WordExpress the main areas of the ISO's importance are in the adoption of 
measurement standards, paper sizes and also character sets. In general most countries in the world have 
adopted ISO standards. The USA have retained some of their own standards such as letter size 
stationery that differ from the rest of the world.



Character Sets
To use alternative characters such as international characters with accents the easiest method is to locate 
the character you want by running Windows own Character Map program. 

In Windows 3.1 use FILE | RUN and type in CHARMAP followed by clicking on the OK button.

In Windows 95 use START | RUN and type CHARMAP followed by clicking on the OK button.

For more information on the Character Map program please refer to you Windows documentation.



Bullet
A bullet or a bullet style is a type of word processor formatting in which each point is highlighted. The text 
is usually then indented. Bullets can be numbered or highlighted graphically. A quick example is below.

1. First bullet
2. Second bullet

Note: This example is very simple. WordExpress supports several kinds of bullets.



Footnote
Footnotes should not be confused with footers. A footnote is a way of placing a reference in the text to 
another piece of important information so as not to distract the reader from the main text. 

For example an academic book may mark quotes taken from other sources with the footnote explaining 
the source. The footnote itself can appear at the bottom of a page, at the end of a chapter or at the end of 
a book. 

Footnotes are normally used for long documents.



Footer
A footer normally appears at the bottom of a page. Typically it might contain the page number on a long 
document or perhaps, on letter heading, your address. Sometimes people confuse the word footer with 
footnote. Footnote is described separately in this glossary.



Toggle
Toggle, in computing terms, is a menu or other option that has two states. If the option is clicked it moves 
from one state to another. A new feature of WordExpress is "toggle case" this causes a highlighted piece 
of text in upper case to turn into lower case with one mouse click. A second click would reverse the state 
to the original form.

Toggles are used widely in computer software.



Version
The word version is used frequently in computer software to describe the development of a program. 
WordExpress is now up to version 2. Typically versions are expressed as 2.0 and 2.1. The decimal point 
illustrates the degree of difference in a version. So a change from version 1.0 to 2.0 is a big change 
where actual features are added whereas a change from version 2.0 to 2.01 is a tiny change where a 
feature may be modified or even just a piece of text changed in the help file.

It is a widely held belief that version changes mean that some bug has been fixed and if you don't have 
the latest version of a program then your software is faulty. In fact it's more usual for a version change 
below the decimal point to mean that a cosmetic change has been made to a prompt that won't have a 
major effect on most customers.



PC8
PC8 is the IBM and Hewlett Packard name for what most of us call ASCII. The only difference is that 
ASCII is really only a standard for the US character set whereas PC8 includes international characters 
too.

Sometimes the PC8 character set is described as the Latin-1 character set and sometimes as "codepage 
850". While there are precise differences in these terms the people using them are still usually referring to 
the PC8 character set.



Latin-1
Latin-1 is the extension of the US character set that includes many international characters for languages 
other than US English. It adds additional letters to the ASCII character set. The term Latin-1 is freely 
swapped with terms like PC8 and "codepage 850". Basically they all mean the same - the US ASCII 
character set plus support for international characters.

Latin-1 is the terminology used by the CompuServe Information Service for it's international character 
support.



CompuServe
CompuServe is an international electronic information service based in Columbus, Ohio, USA. 
CompuServe provides electronic mail and Internet access worldwide and a number of software 
companies have support areas on CompuServe. 

To access CompuServe, or any electronic information provider, you require a modem and 
communications software. Software is often available free from the information provider.

Note: MicroVision and many of our international distributors can be contacted by email for sales and    
technical support. 



E-Mail
E-Mail simply means electronic mail. This can be via an information provider like CompuServe or via your 
office local area network. 

In Windows 95 Microsoft have bound their FAX facilities closely to their e-mail program so if you wish to 
FAX a WordExpress document you need to install Microsoft Exchange. The SEND option in WordExpress 
also uses these facilities.



Text Mode
In WordExpress you can work in "text mode" or "object mode".

Text mode allows you to type characters into a document and use features like bold and underline. 

Object mode allows you to manipulate pictures, text boxes or do any kind of operation that involves 
objects on the screen.

While in object mode you cannot edit text and while in text mode you can't move objects. 



Object Mode
In WordExpress you can work in "text mode" or "object mode".

Text mode allows you to type characters into a document and use features like bold and underline. 

Object mode allows you to manipulate pictures, text boxes or do any kind of operation that involves 
objects on the screen.

While in object mode you cannot edit text and while in text mode you can't move objects. 



PCX
PCX is the file extension for pictures created with the PC Paintbrush program originally marketed by 
ZSoft. Many other programs can now create and use PC Paintbrush files.



WMF
WMF is the file extension given to Windows Meta Files. A "metafile" is a graphic image that can contain 
both vector information and bitmap (or raster) information. In fact because of the difficulties of converting 
a bitmap image to a vector image a WMF may end up just being an ordinary bitmap.

Some people erroneously use the word vector and metafile to mean the same thing. A metafile may be 
100% vector image but it may not. It is unlikely to be a vector image if it has gone through some image 
conversion. 



Vector
A vector image is an image created by joining points together by lines. Because the image is "calculated" 
it can be enlarged or reduced without using resolution.

One confusing aspect of vector images is that a Windows MetaFile (WMF) can contain both bitmap and 
vector portions. It is therefore incorrect to use vector and metafile to mean the same thing. 



I-Beam
In WordExpress the "I-Beam" is the symbol on the control strip that switches you to text mode. 



TIF
TIF is yet another graphics format. This time it is an official Microsoft format called the Tag Image Format. 
Developed originally in the 1980s it has several variations and is still undergoing ongoing development. 
Unfortunately this means that not every program supports every variation of the TIF format. 



JPG
JPG is the JPEG graphics format. Files with this extension are normally compressed. JPG is not normally 
supported directly by programs like Word Processors because there are a variety of variations in the 
format. 

Specialist graphics conversion programs are best used with JPG files. Save them in BMP, PCX or TIF 
format so that WordExpress can properly use the file.



GIF
GIF is the CompuServe Graphic Interchange Format. So called because it is a format not only supported 
by PCs but also by MacIntoshes and other computers. It is also one of the most common graphic formats 
found on the Internet. 

Files with the extension GIF are likely to be in this format. WordExpress cannot support GIF directly and 
GIF files should be converted to BMP, PCX or TIF to be used by WordExpress.



DBF
DBF is the file extension used by files that support the dBase file format. As well as dBase itself a number 
of Windows databases are able to use the format including; Microsoft Access, Lotus Approach and 
Borland Paradox.



Untitled
When WordExpress doesn't know the name of a document that you are using it calls it "untitled". This is a 
common Windows method of alerting you to documents that you have not saved with a specific name. 

Note: You can have several "untitled" documents open at the same time.



Orientation
Orientation is used most frequently with reference to way in which paper is printed. 
The two forms of "orientation" are portrait where paper is printed in the conventional manner and 
landscape where paper is printed sideways on.



Portrait
Portrait normally refers to the conventional printing of paper in a printer. It is used in opposition to the 
word "landscape" which means turning paper sideways for printing. Portrait and landscape printing is 
controlled by the Page and Printer Setup menus.



Landscape
Landscape in the context of word processing means printing sideways. It is used as a contrary position to 
portrait printing which is the normal way in which most documents are printed.

landscape printing is controlled in the Page Setup and Print Setup menus.



Driver
A "driver" in the context of Windows software is a program that communicates with another piece of 
software. 

For example WordExpress does not communicate directly with your printer but with a piece of software 
provided by your printer manufacturer called the printer driver.

 So when WordExpress wants a document to be printed it does all the formatting and then passes the job 
to the printer driver. The printer driver then tells the printer how to print the document. 

Similarly there are other drivers for tasks such as displaying information on the screen - the video driver.

Drivers react with software all the time and mostly in the background.



Video Card
The video card is the electronics, usually on a separate board (card) inside your PC, that carries the 
images you see to the monitor. All PC's have a video card - even if the card is no longer a separate piece 
of electronics but is built onto the motherboard. 

In order for Windows to communicate with the video card a separate program called the video driver must 
be installed. This is done automatically by Windows when it is first put on your computer.



Master Page
The master page in WordExpress is the page that acts as a template for all the pages in your document. 
For example, you can set the master page to have specific headers and footers that will be reproduced 
throughout the whole document.

Objects on the Master Page are added by selecting the Master Page from the View menu.    Any object 
added while on the Master Page will then be repeated for the remainder of the document. 

Once placed, you can also edit Master Page objects anywhere in the document.



Emulate
Emulate is a general computing term referring to the ability of some hardware or software to pretend to be 
something else. For example a printer "emulating" Hewlett Packard is understood to be able to work in 
exactly the same way a Hewlett Packard printer would. 

Of course like any good impressionist the ability to copy something else is not always 100% successful.

 



Tutorial
If you are new to WordExpress you might want to try a few straightforward exercises to get you familiar 
with the keyboard. These are not designed as a formal tutorial with lessons that you have to complete 
before you can use the program. Instead the topics below take you through some basic information and 
provide some instruction on the features you might wish to use when starting out with WordExpress.

Don't worry if you skip things you are not interested in. There is no examination to face later! Elsewhere 
we provide hints, tips and troubleshooting advice if you run into problems. 

Basics 
Templates 
Creating a New Document 
Opening an Existing Document 
Saving a Document 
Mouse Actions (Using the Right Mouse)



Basics

WordExpress is a tool designed for creating documents such as letters, memos, fax cover pages, reports, 
newsletters, and brochures. It contains commands and features for creating both simple and 
sophisticated documents. You have complete formatting control over characters (font, size, style), 
paragraphs (indentation, tabs, line height), and whole documents (margins, page size).

Documents you create with the WordExpress can include headers and footers, multiple columns, and 
auto fields such as date, time, and page numbers. You can draw simple objects such as lines, rectangles, 
and ellipses. You can also create specialized objects such as text frames, tables, and picture frames -- 
into which you can import Windows Metafile (WMF ), Tag Image File Format (TIF ), PC Paintbrush 
(PCX ), and Windows Bitmap (BMP ) files.

WordExpress has two basic modes: text and object. Text mode is the default mode. This is where you 
enter, edit, and format text. Object mode (also referred to as pointer mode) is where you draw objects and 
frames, import pictures, and create grid lines. You switch between the two modes by clicking the 
appropriate button on the control strip -- the I-beam button places WordExpress in text mode; the pointer 
button places it in object mode. Clicking the right mouse button switches between modes also or you may 
choose the "Text Mode" or "Object Mode" commands from the View menu.

The control strip changes depending on which mode is active. In text mode, the control strip contains 
command buttons for formatting text, changing alignment options, and creating tabs, as well as menus for 
selecting font, font size, and paragraph styles. A paragraph style is a collection of formatting commands 
which can be applied all at once. In object mode the control strip contains buttons for drawing text frames, 
picture frames, tables, and simple objects.

You can control the display of certain WordExpress tools. For example, you can turn the display of the 
rulers and control strip off, giving you more room on screen for your document contents. You determine 
display options by choosing commands from the View menu.

A spell checker and thesaurus let you check for spelling mistakes, correct them, and search for synonyms 
(words with similar meanings). You can add your own words to a customized user dictionary. This is 
useful for words such as personal names and acronyms.

You can also print merge your documents with data from Comma Delimited (CSV ) or dBASE (DBF ) files. 
Print merging is useful if, for example, you want to print the same document several times, but change 
address information for each document. If you have a datafile containing names and addresses, 
WordExpress will substitute the fields you specify from it each times it prints a copy of the document.

Click on Tutorial to return to the tutorial main page or use the contents button to return to the main help 
section. 



Templates
To understand how to create a new document you have to first follow how WordExpress creates new 
documents.

When you start a new document it is based on a template. A template is simply a special kind of 
WordExpress document that contains the attributes for the kind of document you want to create. 

The most basic template is the normal template. The normal template is supplied pre-configured with 
WordExpress. The template sets up the page size, the margins, whether the page has a header or footer 
etc. All of these things you can set up in a regular WordExpress document but using a template allows 
you to store these things for use every time you start a new document.

One of the most common templates people make is one with their name and address located in the 
template. To do this carry out the following steps;

1. Start a new document but leave it "untitled" for the moment. 

2. Press the TAB key a few    times to position the cursor towards the far right hand edge of the screen. 
If you go too far just press the backspace key to delete the tab stops. Type in the first line of your 
address.

3. Repeat step "2" for the second and subsequent lines of your address. 

You have now created a document that has all your address details in it. Save the file by clicking on File | 
Save. Note that the save dialog has a space for the type of document this is. Use the arrow button to the 
right to make sure TEMPLATE is the document type. Make sure that WordExpress is offering you the 
template directory (folder) to save your document in. Give the file a name like ADDRESS. 

You now have an address template. When you start a new file it will be listed with other templates so you 
never need type your address again when starting a letter.

Note: If any of the above terms like directory, folder, document or file are alien to you then click on the 
Glossary button. All the terms we use regularly are defined in the Glossary.

Click on Tutorial to return to the tutorial main page or use the contents button to return to the main help 
section. 



Creating a New Document
Assuming you are now familiar with templates then the creation of new documents is straightforward. 
(See Templates if you are unfamiliar with templates).

When you do a File | New then WordExpress will automatically provide you with a list of templates to 
base your new document on.    Thus the templates supplied with WordExpress and the ones you create 
yourself can make a good foundation for creating interesting and attractive documents. 

Choose one of the templates. Most are named according to the kind of function they perform. If you want 
to edit an existing template then simply do a File | Open making sure the document type is called 
"template".

Try not to save documents in the template directory or save templates in anything other than the template 
directory otherwise you may end up confused when trying to find files later on.

Note: WordExpress expects to find templates in the templates directory !

Click on Tutorial to return to the tutorial main page or use the contents button to return to the main help 
section. 



Opening an Existing Document
To edit a document on your system you must first open it. This is done from the File | Open menu.

You will then be presented with a standard Windows dialog box allowing you to navigate your hard disk 
for the required file.    Since these dialogs are standard dialogs it is beyond the scope of the WordExpress 
documentation to discuss them in detail. However you should note that the file type appears in a box and 
this can be altered to whatever file type you wish to open.

An alternative method of opening WordExpress (or other) documents is to use the WordExpress File 
Finder. This is located on the File | Find File menu. 

Click on Tutorial to return to the tutorial main page or use the contents button to return to the main help 
section. 



Saving a Document
There are basically two types of "save" in WordExpress called "save" and "save as". The difference 
between them is the type of file that can be created.

When you open a new document    WordExpress will give it the title "Untitled". When you save an untitled 
document WordExpress does not know whether the document will be saved in it's own format or another 
format like RTF. As a result the first save is always a "save as" allowing you to choose what kind of 
document you wish to save it as. 

If the document is saved as a WordExpress document then future saves will not bring up dialogs because 
the program will know that the document is a WordExpress document.

Click on Tutorial to return to the tutorial main page or use the contents button to return to the main help 
section. 



Mouse Actions
Because WordExpress is a Windows program it tries to use the mouse at all times as you might expect a 
Windows program to work. In fact this tutorial section is almost the only place we mention this because 
we assume you are aware, from other Windows documentation, the main mouse features. 

Thus if you hold down the left mouse button and drag the mouse across an area that area will be 
highlighted. Any action will now apply to the marked area.

However a new feature of the mouse is the use of the right mouse button. This was first made use of in a 
standard way in Windows 95. WordExpress uses the right mouse button in the way a Windows 95 user 
might expect - namely to alter the properties of the current highlighted object.

Click on Tutorial to return to the tutorial main page or use the contents button to return to the main help 
section. 

 



Reference Guide

You can navigate this command reference by clicking on the portion of the screen you are interested in 
getting assistance with. If you cannot see the whole graphic in your help window then please maximize 
the window. 



File Menu 
Below is a representation of the File Menu options you can see normally in WordExpress. to view help on 
a particular topic click on the menu item.

{bml WEWIN03.SHG}



Edit Menu

Below is a representation of the Edit Menu options you can see normally in WordExpress. to view help on 
a particular topic click on the menu item.



View Menu
Below is a representation of the View Menu options you can see normally in WordExpress. to view help 
on a particular topic click on the menu item.



Format Menu
Below is a representation of the Format Menu options you can see normally in WordExpress. to view help 
on a particular topic click on the menu item.



Object Menu
Below is a representation of the Object Menu options you can see normally in WordExpress. to view help 
on a particular topic click on the menu item.



Insert Menu
Below is a representation of the Insert Menu options you can see normally in WordExpress. to view help 
on a particular topic click on the menu item.



Table Menu
Below is a representation of the Table Menu options you can see normally in WordExpress. to view help 
on a particular topic click on the menu item.



Utility Menu
Below is a representation of the Utility Menu options you can see normally in WordExpress. to view help 
on a particular topic click on the menu item.



Window Menu
Below is a representation of the Window Menu options you can see normally in WordExpress. to view 
help on a particular topic click on the menu item.



New
  
File | New

Use "New..." to create a new document or template.    Choosing this command displays the "New" dialog 
box from which you select a template and specify whether you want the new document to appear in a 
new window. (See Template for more information about templates).

New Dialog Box

Set Default: Click this button if you want the selected template to be the default template when you start 
WordExpress. The new dialog box will also default to this template.

TIP: If you make an error and make the wrong template the default simply find the template you really 
wanted and click the button again.

New Window: Check this option if you want WordExpress to create the new document in a new window. 
If this option is not checked, WordExpress will use the current window for the new document; if the 
current window contains a document that has unsaved changed, you are prompted to save them first.

Keyboard Shortcut

Create a new document CTRL + N



Open

File | Open

Use "Open..." to open an existing document or template.    Choosing this command displays the "Open" 
dialog box where you can select from a list of documents or templates. (See Template or Document    for 
more information).

Open Dialog Box

The Open Dialog uses a standard Windows based dialog for you to select files, directories and navigate 
where your documents are stored. This dialog will differ between the Windows 3.1 version and the 
Windows 95 version.

Dialog Boxes include:

List Files of Type: Select options from this menu to tell WordExpress the type of document you want to 
open - normal document files (the default), templates, text files, RTF (Rich Text Format) files or any other 
types that WordExpress has filters for.    The type you choose here determines the available files in the file 
list. (See Filter for more information on file filters).

Note: WordExpress supplies a filter to open pages downloaded from the Internet with the extension HTM. 
However you cannot save files in this format.

File Manager: Actives the "File Manager" function that searches for WordExpress documents.

Select the drive and directory where you want WordExpress to look for documents from the Drives and 
Directories list boxes. You can also create new directories (folders) from this dialog.

Keyboard Shortcut

Open a document CTRL + O



Close
File | Close

Use "Close" to close the current document window.    If unsaved changes have been made to the 
document, you will be prompted to save them first.    You can save them, ignore them, or cancel the 
"Close" command.

Keyboard Shortcut

Close a document CTRL + W    or    CTRL + F4



Save
File | Save

Use the "Save" to save any changes you have made to the current document.    If this is the first time you 
have saved the document, choosing this command displays the "Save As" dialog box where you can 
specify a file name and directory. (See SAVE AS for information as to how to change names or save as a 
different file type).

TIP: Save your documents periodically to guard against accidental loss of data.

Keyboard Shortcut

Save a document CTRL+S



Save All
File | Save All

Use this option to unconditionally save current files you currently have open.

Keyboard Shortcut

Save All documents            ALT + F, L



Save As
File | Save As

Use "Save As..." to save the current document with a new name and/or directory location.    If you enter a 
filename and directory of an existing document or template, another dialog box is displayed asking 
whether you want to overwrite the existing file.    Choosing "Yes" overwrites the existing file; choosing "No" 
returns you to the "Save As" dialog box where you can enter a different name or directory.

Save As Dialog Box

Filename Box: Enter a name for the document.    The default filename extension for documents is WD2 
and is automatically appended to the filename you enter, unless you enter a different extension.    The 
default extension for templates is WT2.

Notes: Changing the name does not change the file format. If you want to save your document as an RTF 
file (for example) you must choose RTF as the document type. 

 "Type Box": You can save WordExpress document files as different types:

· Document (*.WD2) - the native format for WordExpress files.

· Template (*.WT2) - saves the document as a template.    Templates are pre-configured documents.    
Their purpose is to provide initial settings for new documents you create.    These initial settings might 
determine the default font, character and paragraph styles, page dimensions, the placement of 
indents and tabs, even pre-typed text and graphics such as logos and addresses for letterhead - 
virtually anything that can be saved with a document can also be saved in a template.

· DOS/PC-8 Text (*.TXT) - saves the document as a plain text file.    Formatting information and 
graphics are not included in text files.    Text files can be opened and edited by all word processors.

· Windows ANSI Text (*.TXT) - the same as a DOS text file, but saves text using the Windows ANSI 
character set.

· Formatted ASCII (*.TXT - the same as a DOS text file, but saves with the lines wrapped correctly and 
paragraphs formatted so that the file could be used for on-line documentation. Particularly suitable for 
circumstances where you want to upload documentation to an on-line information service.

· Rich Text Format (*.RTF) - saves the document and formatting information (fonts, styles, etc.) in a 
format capable of being transferred between different applications or different computers, such as 
Macintosh.

· Windows Write (*.WRI) - saves the document with formatting suitable for the Windows Write program 
that comes with Windows 3.0 or Windows 3.1. You can save in formats that are suitable for either 
version of Write.    Note: this choice will only appear if the Write document filter has been installed.

· Word for Windows 2.0 or 6.0 (*.DOC) - saves the document in Word for Windows format. These two 
formats can be read by the current versions of Word being used in most offices.    Note: this choice 
will only appear if the Word document filter has been installed

Note: Other document types are available by installing the optional document filters.

TIP: Most other Windows word processors can read and write RTF format. If the specific format isn't 
listed above try using RTF.



Create Dir: Click this button to bring up the "Create Directory" dialog box which allows you to create a 
directory.    You may enter an absolute path or a path which is relative the current directory.    After the 
directory is created, the current directory will be set to that directory and you will be returned to the "Save 
As" dialog box. 

Note: The "Create Dir" choice is only available in Windows 3.1 from a button. In Windows 95 the same 
choice is on the standard dialog.

Select the drive and directory where you wan the file to be saved from the Drives and Directories list 
boxes.

Keyboard Shortcut

Save As ALT + F,    A



Insert
File | Insert

Use    insert as a timesaving feature. This replaces the need to open a file, select text, copy the text to the 
clipboard and paste it into a document. 

The insert function only inserts body text.    Objects attached to the page (i.e. objects created using the 
object tools, as opposed to Insert / Picture and Insert / Table) are not inserted.

Keyboard Shortcut

Insert ALT + F, I



File Manager
File | File Manager

Use file manager to locate your WordExpress documents quickly. 

Initially the dialog is opened with only search, cancel and help available. Clicking on search pops up a 
further dialog for you to fill-in details of your search criteria.    Later, when you have specified the files to 
search for, the other options become available.

These options allow you to print, delete, preview, open or close a document. 

TIP: Fill in your file summary when editing a document to make it easier to find files later on.

Associated Topic: File Search (Dialog)

Keyboard Shortcut

File Manager CTRL + D



Summary
File | Summary

The summary is the place to keep notes about the document that you are editing. You are not required to 
fill in a document summary when creating a new document. However if you have filled in a summary it 
becomes much easier for the WordExpress File Manager to locate that document later on.

Associated Topic: File Manager 

Keyboard Shortcut

Summary CTRL + T



Page Setup
File | Page Setup

Use "Page Setup..." to change document orientation, paper size, margins, page numbering, and the 
starting page for headers and footers.    Note that you can also change the page size on a chapter by 
chapter basis using the Page Setup option in the Chapter dialog box

Page Setup Dialog Box

Orientation: Click "Portrait" for a top-to-bottom page orientation (long edge vertical); click "Landscape" 
for a side-to-side page orientation (long edge horizontal). See Orientation, Portrait or Landscape in the 
Glossary for more information.

Paper Size: Choose from several different paper and envelope sizes. The default paper size will be 
based on the settings of the document or the default template. Typically in the United States this will be 
US letter and in rest of the world A4. 

Margins: Enter values for left, right, top, and bottom margins.    Margins are the white space around the 
borders of a page. These values will depend on the measurement settings in Windows. In the USA the 
typical setting will be in inches whereas in the rest of the world the values will be expressed as 
centimeters.

By default, the paper size and margins are specified in the default units specified in the Window’s control 
panel, but you may specify them in inches, centimeters, or points by following the number with the letters 
"in", “cm”, or "pt" (e.g. 1.00in, 2.54cm, or 72.0pt).

TIP: If you change your page size you should check your document for unexpected page breaks due to 
the change. 

Keyboard Shortcut

Page Setup ALT + F,    G



Print
File | Print

Use "Print..." to print one or more copies of the current document to the active printer (the printer you 
select from the "Printer Setup" dialog box).

Print Dialog Box

Copies: Enter the number of copies you want printed, if you want more than one.

Odd/Even: Check the odd and even boxes to print the whole document. If you check the even box only 
then only the pages with even numbers will be printed. If you check the odd box only then only the pages 
with odd numbers will be printed. 

Note: This function is useful for printing two sided documents. To do this, follow the following steps.

1. Print the document and check the Odd check box, and un-check the Even check box.    This 
will print all of the odd pages of the document.

2. Take the pages and turn them over and put them back into the paper feed tray of your printer. 
Important: If you have an odd number of pages in you document, you need to remove the 
last page before you put them back into the feed tray.    This is because there will be no even 
page which corresponds to the last page.

3. Print the document a second time and this time check the Even check box and un-check the 
Odd check box.    Note that the Reverse Order check box becomes checked.    This is 
because when you turned the originals over, they are now in reverse order (i.e. the last page 
is be first).    Thus, you need to print the last page first in order for the fronts and backs of the 
pages to match up correctly.

Pages: If you leave "All" selected, WordExpress prints all pages in your document.    Click "Current Page" 
to print the page where the cursor is located.    To print a range of pages, enter the beginning and ending 
page numbers in the "Pages" boxes.

Print To File: This option lets you print to a disk file rather than to a printer.    After selecting "Print To File" 
and clicking "OK", a dialog box is displayed prompting you to enter an output filename.    Enter the path 
and filename, then click OK to create the output file.

Collate Copies: This option prints one complete copy of the document before printing the next copy.

Drop Pictures: Click this option if you do not want imported pictures to be printed.    This is useful for 
printing drafts, for example.

Reverse Order:    Reverse the printing so that instead of printing pages 1,2,3 it prints 3,2,1.    This is 
useful for printing two sided copies.    See the discussion above.

The buttons on the right of the dialog have the following functions:

OK: Accept these settings and print.

Cancel: Return to the previous menu or dialog.

Printer Setup: Access the printer setup dialogs.

Set Merge File: Associate a database with this document.

Merge: Activate mail merge options. These extend the dialog box to include additional options to allow 



you to print a range of records from the database. See How do I create a mail merge ? for more 
information on this series of functions.

Associated Topics: Print Setup 
Merge Field 
Printer Problems 

Keyboard Shortcut

Print a document CTRL + P



Print Envelopes
File | Print Envelopes

Use "Print Envelopes..." to print envelopes of several standard types.    You can print a single envelope, or 
print several envelopes using address data from a merged field.

Print Envelopes Dialog Box

Address To Tab

Address To: Enter the address of the addressee.    If document text is selected when you choose the 
"Print Envelopes..." command, that text is automatically placed into this field.    If no text is selected, 
WordExpress will attempt to find an address in your document and place that address in this field.

Merge Fields: If you have a merge file selected, then you may choose to add merge fields to the 
"Address To" field.    To add a merge field, select the desired field and click the "<<Add" button.    The field 
will be inserted at the current cursor location in the "Address To" field.    You can also type the field name 
by surrounding it with '{}' (e.g. {FIELDONE}).

Font: Choose the typeface you which to use for the address

Style: Choose the font style desired for the address.

Point Size: Choose the point size desired for the address.

Return Address Tab

Return Address: Enter the return address.    Once you have entered an address here, the same address 
will be filled in the next time you choose to print envelopes.    Note that the return address will only be 
printed if you have selected the "Print Return Address" option.

Font: Choose the typeface you which to use for the address

Style: Choose the font style desired for the address.

Point Size: Choose the point size desired for the address.

Envelope Type: Choose the type of envelope desired.

Print Return Address: Click this option if you wish for the return address to be printed.

Print: After you have entered the addresses and set the other options to your satisfaction, click this 
button to print the envelope.

Additional Topic: Print Setup 

Keyboard Shortcut

Print Envelopes ALT + F, E



Print Setup
File | Print Setup

Use "Printer Setup..." to select the active printer and specify printer-specific options. 

Printer Setup Dialog Box

Printer: Choose the printer you wish to use for future print jobs from this list. Usually you have a choice of 
the default printer for your system or a specific printer from the drivers that are installed. (See Driver    for 
more information on drivers).

Options: Click on this box to set-up printer specific options.

Associated Topics: Page Setup 
Print 
Print Envelopes 

Keyboard Shortcut

Print Setup ALT + F, R



Send
File | Send

Use send to mail the current document to someone else. 

Send Dialog

The send dialog allows you to mail the documents in the following formats.

WordExpress 
RTF
Formatted ASCII Text

Note: The "sending" of the document itself is done by the mail program installed on your computer. The 
mail program must be compatible with Microsoft's MAPI protocol. In the case of Windows 95 using Send 
causes Microsoft Exchange to be launched. (See MAPI for more information).

Keyboard Shortcut

Send ALT + F, D.



Exit
File | Exit

Use "Exit" to quit WordExpress and return to the Windows' Program Manager.    If any unsaved changes 
have been made to open documents when you choose this command, you are prompted to save them 
first.

Keyboard Shortcut

Exit WordExpress CTRL + Q    or    ALT + F4



History
As with most modern Windows applications the most recent files opened are "remembered" by 
WordExpress. This is referred to as the "history window". If you click on any of the items in the history list, 
the file is loaded immediately.

Note: The history is saved when you leave WordExpress. If you have deleted a file in the history list or    
moved it or renamed it    between word processing sessions then the history list will not be able to recall 
the file. 



Undo
Edit | Undo
Edit | Redo

Use "Undo" to reverse the effect of the last action you performed, such as typing, deleting or formatting 
text, creating or moving graphic objects, inserting a page break, etc.

The name of this command changes to reflect the exact nature of the action you want to undo.    For 
example, if you just deleted some text by selecting it and pressing the Delete key, the command name 
changes to "Unto Typing".    If you just formatted some text to Bold, the name changes to "Undo Format". 
If you just inserted a page break, the name changes to "Undo Insert Page Break".

Upon selecting an "Undo" command, the command changes to "Redo".    The "Redo" command lets you 
undo the last "Undo".

Keyboard Shortcuts

Undo or Redo ALT + BACKSPACE    or    CTRL + Z



Cut
Edit | Cut

Use "Cut" to delete the selected text or objects from your document and place it on the Clipboard where it 
can be pasted elsewhere in the document, or to a different document.

Text and pictures can be cut and pasted to other Windows programs such as Paintbrush or Write, but 
objects created with WordExpress can only be cut and pasted to other WordExpress documents.

The name of this command changes to identify what you are about to cut.    For example, if you selected 
some text, the command name changes to "Cut Text".    If you selected an object such as a graphic or 
frame, the name changes to "Cut Object".

Keyboard Shortcut

Cut text or objects SHIFT + DEL    or    CTRL + X



Copy
Edit | Copy

Use "Copy" to place a duplicate of the selected text or objects onto the Clipboard where it can be pasted 
elsewhere in the document, or to a different document.

Text and pictures can be copied and pasted to other Windows programs such as Paintbrush or Write, but 
objects created with WordExpress can only be copied and pasted to other Word
Express documents.

The name of this command changes to identify what you are about to copy.    For example, if you selected 
some text, the command name changes to "Copy Text".    If you selected an object such as a graphic or 
frame, the name changes to "Copy Object".

Keyboard Shortcut

Copy text or objects CTRL + INS    or    CTRL + X



Paste
Edit | Paste

Use "Paste" to place the contents of the clipboard (the last text or object you cut or copied) back into the 
document, or to a different document.

The name of this command changes to identify what you are about to paste.    For example, if you just cut 
or copied some text, the command name changes to "Paste Text".    If you cut or copied an object such as 
a graphic or frame, the name changes to "Paste Object".    Certain objects can be pasted in text mode as 
well as object mode - pictures and tables.    By pasting a picture or table in text mode, you can anchor it to 
the text.

Keyboard Shortcut

Paste text or objects SHIFT + INS    or    CTRL + V



Paste Special
Edit | Paste Special

Use "Paste Special .." when you need to control the format of an object you wish to past into a document. 
For example a graphic produced with Paintbrush can be pasted in as an Bitmap Image (i.e. OLE object), 
Window’s Metafile, or a Device Independent Bitmap (DIB).    Paste special is only available in pointer 
mode.

Keyboard Shortcut

Paste Special ALT + E, I



Select All
Edit    | Select All

Use "Select All" to highlight, or select, all text in the document, or current text frame, if you are in text 
mode, or all objects on the current page if you are in object mode.

TIP: Select all is particularly useful when you have read in a plain text file and you want to change it to 
your favorite font. 

Keyboard Shortcut

Select all text or objects CTRL + A



Search
Edit | Search

Use "Search..." to search the document, including text frames, for specific text.

Search Dialog Box

Search For: WordExpress can search for any text you can enter from the keyboard. To locate a carriage 
return, enter ‘^n’, to locate a tab, enter ‘^t’.    To locate a carriage return which is not immediately followed 
by a blank line, use ‘^r’.    This is useful for removing extra carriage returns when importing ASCII 
documents.    You can search for ‘^r’ and replace it with nothing.

Ignore Case:    By default, the Search command is not case-sensitive.    With Ignore Case off, or un-
checked, WordExpress locates text exactly as you type it, looking for exact matches of upper and lower 
case letters.

Whole Word: You can search for whole words, or just for text embedded within other words.

All Frames: Check this option if you want WordExpress to search for text in text frames as well as normal 
document text.

Backwards:    WordExpress can search forward (to the end of the document) or backward (to the 
beginning of the document) from the cursor location.

Find Next: Click the "Find Next" to begin the search.    If WordExpress can't find the search text, it 
displays a message.    If this happens, you might want to change the direction of the search and click 
"Find Next" again.

Done: Click this button to close the "Search" dialog box.

Character: Displays the "Character" dialog box.    You can tell WordExpress to search only for text that 
matches the formatting attributes you specify.    For example, if you check the "Italic" option, WordExpress 
only searches for italicized text.

Paragraph: Displays the "Paragraph" dialog box.    This lets you search only in paragraphs that are 
formatted with the attributes you specify.

Clear: Click this button to remove any character and paragraph formatting attributes you may have 
specified.    WordExpress will then search in all text, regardless how it's formatted.

Replace: Clicking this button changes the dialog box to the Replace dialog box, where you can choose to 
replace the search text with replacement text you specify.

Keyboard Shortcut

Search CTRL + F



Replace
Edit | Replace

Use "Replace.." to search for and replace one text string with another.

Replace Dialog Box

Search For: WordExpress can search for any text you can enter from the keyboard. To locate a carriage 
return, enter ‘^n’, to locate a tab, enter ‘^t’.    To locate a carriage return which is not immediately followed 
by a blank line, use ‘^r’.    This is useful for removing extra carriage returns when importing ASCII 
documents.    You can search for ‘^r’ and replace it with nothing.

Replace With: Specify the text you wish to replace the matched text.

Ignore Case:    By default, the Search command is not case-sensitive.    With Ignore Case off, or un-
checked, WordExpress locates text exactly as you type it, looking for exact matches of upper and lower 
case letters.

Whole Word: You can search for whole words, or just for text embedded within other words.

All Frames: Check this option if you want WordExpress to search for text in text frames as well as normal 
document text.

Start: Click the "Start" to begin the search.    If WordExpress can't find the search text, it displays an error 
message.    After the first word is found, this button changes to "Skip".    Pressing this button subsequently, 
will case the currently matched word to be skipped and searching will continue starting at the next word.

Replace: Click the "Replace" replace the currently selected word with the text in the "Replace With" field. 
Searching will then continue starting at the next word.

Replace All: Click the "Replace All" if you want to replace all occurrences of the specified word.

Done: Click this button to close the "Replace" dialog box.

Character: If the cursor is in the "Search For" field, then clicking this button allows you to specify the 
character formatting attributes which must be matched as described in the "Search" dialog box.    If the 
cursor is in the "Replace With" field, then clicking this button allows you to specify the character attributes 
which are to replace the matched text.    In this way, you can replace all occurrences of a bold word with 
the same word italicized, for example.

Paragraph:  If the cursor is in the "Search For" field, then clicking this button allows you to specify the 
paragraph attributes which must be matched as described in the "Search" dialog box.    If the cursor is in 
the "Replace With" field, then clicking this button allows you to specify the paragraph attributes which are 
to replace the matched text.

Keyboard Shortcut

Search and replace CTRL + H



Find Next & Replace Next
Use the Find Next command to repeat the last Search command you issued. WordExpress searches for 
the next occurrence of the text you entered in the Search dialog box.

If you have just performed a Replace command, the Find Next command changes to Replace Next. 
Choosing it displays the Replace dialog box after it has located the search text.

Keyboard Shortcut

Find Next & Replace Next F3



Go To
Edit | Go To

Use this option to quickly locate a specific page or bookmark.

Go To Dialog

Enter the page number you wish to go to, or select from one of the previously set bookmarks.    You many 
enter the page as an absolute page number or you may enter a chapter and page number as ‘c-p’ where 
‘c’ is the chapter number, and ‘p’ is the page within that chapter.

Keyboard Shortcut

Go To F5



Bring To The Front
Edit | Bring To Front 

Use the "Bring To Front" and "Send To Back" commands to change the stacking order of overlapping 
objects such as graphics, text frames, and tables.

To move an object to a position behind any other objects, select it with the pointer tool and choose "Send 
To Back".    Choose "Bring To Front" to make it the topmost object on the page.

Keyboard Shortcut

Bring To Front ALT + E, F.



Send To The Back
Edit | Send To Back

Use the "Bring To Front" and "Send To Back" commands to change the stacking order of overlapping 
objects such as graphics, text frames, and tables.

To move an object to a position behind any other objects, select it with the pointer tool and choose "Send 
To Back".    Choose "Bring To Front" to make it the topmost object on the page.

Keyboard Shortcut

Send To Back ALT + E, B.



Preferences
Edit | Preferences

Use "Preferences..." to set preferences for the operation of WordExpress.

Preferences Dialog Box

This dialog is sub-divided into overlapping sections. These sections from left to right are:    General, View, 
Document, User.

Click on the appropriate TAB on the top of the section to view options applicable to the section.

General Tab

Show Control Strip: Click this option if you want the control strip to be displayed.    This can also be 
controlled by using the "Show Control Strip" function on the View menu.

Show Status Strip: Click this option if you want the status strip to be displayed.    This can also be 
controlled by using the "Show Status Strip" function on the View menu.

Show Speed Tools: Click this option if you want the speed tools to be displayed.        This can also be 
controlled by using the "Show Speed Tools" function on the View menu.

Generate Backup Files: Click this option if you want WordExpress to automatically generate a backup 
file each time you save a document.    If set, when you save a document, the current file will be renamed 
to a file with the extension '.BAK'.    Note that if you set this option, the fast save function will be disabled.

Use New Window by default: Click this option if you want the "New Window" check box to be checked 
for "File / New" and "File / Open".

Always Save Pictures w/Documents: Click this option if you always want pictures saved with your 
document.

Always Compress Pictures: If you have checked the “Always Save Pictures w/Documents” option 
above, then clicking this option will cause the pictures to be automatically compressed.    This can result in 
significantly smaller files when pictures are used.

Spell Check and Date Language: Choose the language you want used for the spell check dictionary 
and date formats.

Default Document View: This option allows you to select how you will view documents by default.

Display Optimization: Choose the display optimization you desire from this list.    "Fastest" will result in 
the fastest performance with the greatest screen flicker.    "Best" will result in the least screen flicker but 
may result in slow performance, especially on complex pages or pages with a large number of pictures.

Foreground Color: Choose the color you wish to use for text.

Background Color: Choose the color you wish to have as the background or "paper" that you type on.

View Tab

Horizontal Ruler: Check box to display horizontal ruler.

Vertical Ruler: Check box to display vertical ruler.



Guides: Check box to display guides.

Paragraph Breaks: Check box to display paragraph breaks.

Table Guidelines: Check box to display table guidelines.

Frame Guidelines: Check box to display frame guidelines.

Use as Default View Settings: Changing the above options will only affect the current window.    If you 
want those options to be used as the default for all new windows, click this button.

Note: Leaving a box unchecked disables the above options.

Document Tab

Pictures: You have the option, via radio buttons, of displaying pictures or simply displaying the place 
holders where pictures are located. Displaying place holders rather than the pictures themselves will 
increase the speed of WordExpress.

Lock Master Document: Check to prevent you accidentally modifying a master page.

Lock Guides: Check to prevent you accidentally moving the guides.

Display Field Codes: You can check this box to display the field codes rather than the field data.    For 
example, the date field would be displayed as “{Create Date}” as opposed to “April 15, 1996”

Show Merge Records: If you have a merge file attached, you can check this box to display the merge 
record names rather than the field names.    You may choose any record in the database to display.

Decimal Separator: The decimal separation character is not the same in every country. Place your 
country's decimal separator in here.

User Tab

In the "User preferences" section you are invited to type in information about yourself. Some of this 
information is used by merge fields within the program and your name is used as the default name for 
document summaries. 

For the convenience of customers outside the USA the "STATE" field does not restrict itself    to accepting 
only US state codes. You may fill in county or province details. The "ZIP" code field may be used for 
postal code in countries outside the USA.

Keyboard Shortcut

Send To Back ALT + E, E



Text Mode
View | Text Mode

Use "Text Mode" to switch Text Mode (also know as I-Beam mode) where you enter and format text.    If 
you are in Text Mode, a check will appear next to this command.

You can also switch to text mode by clicking on the ibeam icon    on the control strip or by clicking the right 
mouse button and choosing the first menu entry.

Keyboard Shortcut

Text Mode ALT + V, T.



Object Mode
View | Object Mode

Use "Object Mode" to switch to Object Mode (also know as Pointer mode) which you use to create and 
manipulate objects.    If you are in object mode, a check will appear next to this command.

You can also switch to object mode by clicking on the pointer icon    on the control strip or by clicking the 
right mouse button and choosing the first menu entry.

Keyboard Shortcut

Object Mode ALT + V, O.



Page 
View | Page

Use this option to view your document as pages. This view represents most closely how your document 
will look when printed.

Associated Topic: Page Setup 

Keyboard Shortcut

Page ALT + V, P.



Master Pages
View | Master Pages

Master pages are pages whose contents are repeated on every page of the document.    A common 
example of a master page object is the header or footer.    The header is simply a text frame which is 
placed on the master page.    This causes the header to be repeated on every page.    You can, however, 
put any object on the master page, and that object will be repeated on every page.

Objects on the Master Page are added by selecting the Master Page from the View menu.    Any object 
added while on the Master Page will then be repeated for the remainder of the document.    Once placed, 
you can also edit Master Page objects anywhere in the document, just be aware that the change you 
make on page one will be reflected throughout the document.    When you have added all the objects you 
want, choose “View | Page” to return to normal editing.

Note: You can still move and edit master page items even in page mode unless you have "locked" the 
Master Page using “Edit | Preferences”.

Keyboard Shortcut

Master Page ALT + V,M.



Continuous
View | Continuous

Use continuous view to view the document as a continuous whole. This removes headers/footers from the 
screen and leaves you with the main body text.

Keyboard Shortcut

Continuous ALT + V, C.



Outline
View | Outline 

Use outline to develop a structure for your documents. An outline is effectively the key headings in a long 
document. 

When in outline view the control strip changes and you see your text as a series of levels. The levels have 
two uses. Firstly they form the basis of developing a Table of Contents later. Secondly they allow you to 
create the headings that are going to develop into your document.

Outlines are measured in levels from level 1 to level 9 in WordExpress. The highest and most important 
level being level 1. When you type in the body text of your document then that is outside the level 
structure. However you can display the body text as well by clicking on the "All" button on the control strip

The arrow cursors on the far left of the updated control strip allow you to promote or demote your text. By 
promote we mean increase the outline level - from level 2 to 1 as an example. By demote we mean 
reduce the heading level - from level 1 to level 2 as an example.

If you have only one level of text to begin with then just click on "2" to add a second level. Type in the 
heading and "demote" it, or any other text, to level 2.

The "+" and "-" buttons have the same effect as clicking the numbered levels except that they work 
incrementally. 

To return to a normal view simply select ALT + V, P.

Note: Outlining is a technique to make developing longer documents easier. You do not need to 
understand or use outlining for letters or short documents.

Keyboard Shortcut

Outline ALT + V, I



Outline Level
View | Outline Level

If you have selected View | Outline then you can change outline level by either clicking your mouse on 
one of the numbers on the updated control strip or by using this option.

Click on outline level and you are presented with a dialog that allows you to type in a number 
representing the level of outline you wish to view. 

This option is not available unless you have chosen View | Outline.

Associated Topic: Outline 

Keyboard Shortcut

Outline Level ALT + V, L.



Actual Size
View | Actual Size

If checked this option allows you to see the document in it's actual size.

Keyboard Shortcut

Actual Size ALT + V,A.



Fit Page In Window
View | Fit Page In Window

If checked this option fits the current page in the dimensions of the window that is available.

Keyboard Shortcut

Fit Page In Window ALT + V, W.



Zoom
View | Zoom

If checked this option allows you to zoom in on an area of the screen. After checking the option use the 
mouse by clicking and holding down the left mouse key. 

As you drag the mouse across the screen a rectangular area forms. This is the area that will be "zoomed" 
to. 

After you have zoomed into a particular area the View | Custom option becomes checked because in 
effect you now have a custom view of the page.

Using View | Actual Size will restore the page to normal.

Associated Topics: Custom 
Actual Size 

Keyboard Shortcut

Zoom ALT + V, Z.



Custom
View | Custom

Use to view the page in a variety of different ways. 

View Custom Dialog

This dialog allows you to click on a specific percentage scale for the page.    Actual size is viewed at 100% 
.

If you check the box marked "Use when opening new documents" this will cause your chosen percentage 
size to be the one used when you do a File | New.

Note: View | Custom will automatically become checked if you have used the View | Zoom feature. 
However the dialog will not be displayed as the view will have already been customized by zooming in.

Associated Topics: Actual Size 
Zoom 

Keyboard Shortcut

Custom ALT + V, U



View Options
View | View Options

Use this as a shortcut to the Edit | Preferences | View dialog. It displays the following.

Horizontal Ruler: Check box to display horizontal ruler.

Vertical Ruler: Check box to display vertical ruler.

Guides: Check box to display guides.

Paragraph Breaks: Check box to display paragraph breaks.

Table Guidelines: Check box to display table guidelines.

Frame Guidelines: Check box to display frame guidelines.

Use as Default View Settings: Changing the above options will only affect the current window.    If you 
want those options to be used as the default for all new windows, click this button.

Note: Leaving a box unchecked disables the above options.

Associated Topic: Preferences 

Keyboard Shortcut

View Options ALT + V, V.



Toolbars
View | Toolbars

View | Toolbars | Show Control Strip 
View | Toolbars | Show Status Strip 
View | Toolbars | Show Speed Tools 



Show Control Strip
View | Toolbars | Show Control Strip

Check this option if you wish to display the control strip.

Keyboard Shortcut

View Options ALT + V, S, C



Show Status Strip
View | Toolbars | Show Status Strip

Check this option if you wish to display the status line at the bottom of the screen.

Keyboard Shortcut

View Options ALT + V, S, S



Show Speed Tools
View | Toolbars | Show Speed Tools

Check this option if you wish to display the speed tools strip.

Keyboard Shortcut

View Options ALT + V, S, P



Character
Format | Character 

Use the "Character..." command to change the character formatting attributes of selected text, or to set 
the attributes for new text you type.    Character formatting attributes consist of typeface selection (font 
and font variations such as bold, italic, etc.), font size in points, underlining options, and 
super/subscripting.

The character dialog box is split into two sections: Font /Style, Position/Spacing

Font/Style Tab

Sample: This area of the Character dialog box displays a sample of the currently selected formatting 
options, letting you see the effect of your formatting choices before applying them.

Style: Choose from a list of defined character styles. If you choose to define a new one an extra style 
section dialog is created alongside the "Position/Spacing" section.

Font: Choose from a list of fonts installed in your system.

Point Size: You can either select a point size from this menu, or type in any size between 1 and 999.    
Sizes must be whole numbers.    The unit of measurement for fonts is points.    There are 72 points in an 
inch.

Color: Choose from a list of colors you can apply to text.    If you choose the last entry in the list, “Define 
Colors”, then the Define Colors dialog box will be displayed which will allow you to add new colors or 
change existing colors.

Underline: You may single or double underline your text, and you may specify whether the underline is to 
be continuous or whether only words should be underlined (i.e. spaces and tabs are not underlined).

All Caps: Click this box if you want all your text to be displayed as upper case.    Note that this does not 
actually change the case of your text like the “Format | Toggle Case” function, but rather just displays (and 
prints) it as upper case.    If you un-check this option, the text will return to it’s original case.

Small Caps: Click this box if you want you lower case letters to be displayed as upper case but reduced 
in size.    You can specify the size reduction as a percentage of the normal size.    Once again, choosing 
this option does not change the text, only the display (and printing).    If you un-check this option, the text 
will return to normal.

Position/Spacing Tab

Spacing Amount: You can increase or decrease the amount of space between characters by changing 
this value.    100% is normal. If you make this number larger, more space will be added, if you make it 
smaller, space will be subtracted.

Pitch: You can increase or decrease the widths of the characters in the font by changing this value.    
100% is normal.    If you make this number larger, the characters will become wider.    If you make it 
smaller, the characters will become narrower.

Super/Subscript: Choose "Superscript" to move text above the baseline (an imaginary line where 
characters rest); choose "Subscript" to move text below the baseline.    If neither option is selected, text is 
positioned on the baseline.    The "Position" value determines how much, relative to the normal text 
height, text should be moved up or down - 20% is the default.    The "Size" value lets you specify whether 
super- or subscripted text should be reduced in size.    The default value of 80% means that text will be 



reduced by 20%, e.g., if the point size is 10 points, super- or subscript text would be set to 8 points.

Keyboard Shortcut

Character ALT + R,C.



Attributes
Format | Attributes 

Format | Attributes | Normal 
Format | Attributes | Default 
Format | Attributes | Bold 
Format | Attributes | Italic 
Format | Attributes | Underline 
Format | Attributes | Word Underline 



Normal
Normal Character Attributes

Click on this option and any highlighted text is returned to normal. This means that any character 
overrides are removed and the text is returned to the character attributes defined for the paragraph.



Default
Default Character Attributes

Click on this option and any highlighted text to the default character style defined for the paragraph.    This 
differs from the Format | Attributes | Normal command in that the character attributes are returned to the 
character attributes of the underlying paragraph style.    In many cases, this is the same as the character 
attributes of the paragraph.    In that case, this command will perform the same function as the “Format | 
Attributes | Normal” command.



Bold
Bold Character Attributes

Click on this option and any highlighted text becomes bold.    If the highlighted text is already bold, the text 
will become normal.    A check mark appears next to the command if the highlighted text is already bold.

Note: This option has the same effect as the bold button on the control strip and is a toggle.

Keyboard Shortcut

Bold CTRL + B



Italic
Italic Character Attributes

Click on this option and any highlighted text becomes italic.    If the highlighted text is already italic, the 
text will become normal.    A check mark appears next to the command if the highlighted text is already 
italic.

Note: This option has the same effect as the italic button on the control strip and is a toggle.

Keyboard Shortcut

Italic CTRL + I



Underline
Underline Character Attributes

Click on this option and any highlighted text becomes underlined. If the highlighted text is already 
underlined, the text will become normal.    A check mark appears next to the command if the highlighted 
text is already underlined.

Note: This option has the same effect as the underline button on the control strip and is a toggle.

Keyboard Shortcut

Underline CTRL + U



Word Underline
Word Underline Attributes

Click on this option and any highlighted text becomes word underlined.    If the highlighted text is already 
word underlined, the text will become normal.    A check mark appears next to the command if the 
highlighted text is already word underlined.

Note: Spaces between words are not underlined using this option. Use Underline for a true underline. 
This option is a toggle.

Keyboard Shortcut

Word Underline SHIFT + CTRL + W



Toggle Case
Format | Toggle Case

Use to alter the case of letters. Particularly useful as a "whoops!" key when you have accidentally left 
Caps Lock switched on.

Toggle Case Dialog

The Toggle Case Dialog offers you a choice of options for your highlighted text. 

You can turn the text all upper case, all lower case, toggle the case so upper becomes lower etc., 
capitalize all words or just the first word in the sentence.    (See Toggle    for more information).

Keyboard Shortcut

Toggle Case F4



Paragraph
Format | Paragraph

Use the "Paragraph..." command to change the paragraph formatting attributes of selected text, or to set 
the attributes for the paragraph containing the cursor.    Paragraph formatting attributes are applied to 
entire paragraphs, rather than single characters or words.    Alignment, indents, line spacing, tab 
placement, etc., are examples of paragraph formatting attributes.

The paragraph dialog is split into a common region and 4 sections:    Spacing, Flow, Tabs, Special.

Spacing Tab

The spacing section governs the alignment of the text and the style name.

Indent: You may specify a left, right and first line indent for the paragraph.    The left and right indents 
determine the left and right edges of the paragraph and are measured from the page margins.    The first 
line indent determines the indent for the first line of the paragraph and is measured relative to the left 
indent.    A positive number indents to the right.    A negative number produces what is called a “Hanging 
Indent” which is where the left edge of the first line is to the left of the rest of the paragraphs.

Paragraph Spacing: You may specify the amount of extra space you want above or below the 
paragraph.    This distance is usually measured in points (there are 72 points to an inch) but you may 
enter inches, centimeters, or picas by following the number with “in”, “cm”, or “pi” respectively.    (There 
are 6 picas to an inch).

Line Spacing: This field controls the space between lines and is measured as a percentage of the 
normal spacing.    Using 200% produces double spaced text, using 150% produces 1 and 1/2 line 
spacing.

Alignment: Choose options from the list to apply left or right alignment to a paragraph, or to center or 
justify it.

Paragraph Character: Click on this button to bring up the Character dialog box which lets you set the 
character attributes for this paragraph.

Flow Tab

The flow section deals with hyphenation control, pagination, breaks and the outline level for that 
paragraph.

Hyphenation: Choose one of the three types of hyphenation from the list - "Adjacent Lines," "2 Line 
Separation," or "3 Line Separation."    By default, hyphenation is set to "None" which means that it is 
turned off.

The Adjacent Lines options hyphenates eligible words at the end of each line (if necessary).    The 2 and 3 
Line Separation options hyphenate eligible words, but make sure that at least two or three non-
hyphenated lines appear between each hyphenated line.

Outline Level: This field sets the outline level.    You may enter any level from 0 to 9.    A level of zero 
represents body text.    This number is used by the outliner (see View | Outline) and for Auto Number 
Fields (see Insert | Field).

Column Break: Check this box if you want to force the paragraph to start on a new column.    If the text is 
not multiple columns, then this has no effect.



Page Break: Check this box if you want to force the paragraph to start on a new page.

Keep With Next: Click this box if you want to force the last line of this paragraph to be kept on the same 
page as the first line of the next paragraph.

Keep Together: Click this box if you want to keep a page break (if possible) from occurring in the middle 
of this paragraph.    This can be used in conjunction with “Keep With Next” to force this paragraph to be on 
the same page as the first line of the next paragraph.

Widows/Orphans: Click this box if you want to keep a single line at the beginning or end of the 
paragraph from being left on a page by itself.    This can be used in conjunction with “Keep With Next” to 
force the last two lines of this paragraph to be on the same page as the first line of the next paragraph.

Tabs Tab

This section allows you to set the tabs for the paragraph.    This performs the same function as choosing 
Tabs from the Format menu.    See the Tabs dialog box description for details.

Special Tab

Drop Cap: If you check this box, the first character of the paragraph will be displayed in a large point size 
and the top of the character will be aligned with the top of the rest of the line.    Thus the first character will 
hang down below the baseline of the first line.    The remainder of the paragraph will wrap around this first 
character.

Point Size: If the drop cap box is checked, this field specifies the point size used for the first character of 
the paragraph.

Margin: This specifies the amount of additional space you wish to surround the drop cap character.    
These numbers may be negative to reduce the space.

Dropcap Character: Click on this button to bring up the Character dialog box which allows you to specify 
the complete character attributes to use for the first character.    This is useful, for example, if you which 
the first character to use a different font.

Bullet: Click on this button to bring up the Bullet dialog box which allows you to specify the bullet type (if 
any) to use for this paragraph.    This performs the same function as choosing the “Bullet” command from 
the “Insert” menu.

Border: Click on this button to bring up the Paragraph Border dialog box which allows you to specify the 
type of border (if any) for this paragraph.    This performs the same function as choosing the “Border” 
command from the “Insert” menu.

Shades: Click on this button to bring up the Shades dialog box which allows you to specify the 
background shade (if any) for this paragraph.    This performs the same function as choosing the “Shades” 
command from the “Insert” menu.

Common

The controls which are common to all of the sections are defined below:

Style Name: Choose from a list of defined paragraph styles.    To define a new style, click on the 
“Define>>“ button.

Default: Click on this button to return all of the paragraph settings to the default values defined for the 
paragraph style.



Define: Click on this button to define a new style.    This will cause the following additional tab to appear:

Style Tab

Based On: Choose name of the style upon which this style is to be based.    When a style is based on 
another style, any common attributes will automatically change whenever the base on style changes.    
For example, suppose style “Italic” is based on “Normal”.    Suppose further that both the style “Italic” and 
“Normal” use the font “Times New Roman” and the “Italic” uses italicized text, and “Normal” does not.    
Now if you later change the font of the style “Normal” to say “Arial”, the font of the style “Italic” will also 
change to “Arial” since it is based on “Normal”.    If you don’t want the style to be based on any other style, 
simply choose it to be based on itself.

Next Style: Choose the name of the style that you want to follow this style when you press return.    For 
example you may have a heading style and you want body text to follow.    If you set the “Next Style” to 
“Normal”, then after you type the heading and press carriage return, the style will automatically set to 
normal.

Shortcut Key: You may specify a key combination which will automatically invoke this style.    This is 
particularly useful if you use this style often.

Change: Click on this button to change an existing style.    If you enter a new name in the “Style Name” 
field, then this button will change to “Add”.    In this case, a style of the new name will be added.

Delete: Delete the currently selected style.

Rename: Rename the currently selected style

Keyboard Shortcut

Paragraph CTRL + M



Tabs
Format | Tabs

Use "Tabs..." to set tabs and alter their positions and alignment.    Tabs are used to move the cursor to a 
specific location without using the spacebar.    Tabs are useful for lining up text or numbers in tables, or for 
aligning text to a specific location in the document.    Initially, left-aligned tabs are positioned every 
centimeter from the left margin to the right margin.    You can replace these pre-set tabs by adding your 
own.

Tabs Dialog:

Set Tabs At: This list box displays the list of tab stops you wish to set.    You can add a tab to this list by 
entering the position in the edit portion of the list box and then clicking the “Set” button.    You can remove 
tabs from this list by selecting the desired tab and clicking the “Delete” button.

Clear Tabs At: This list box displays the list of tab stops you wish to delete.    You can add a tab to this list 
by entering the position in the edit portion of the “Set Tabs At” dialog box and clicking the “Clear” button.    
You can clear all tabs by clicking the “Clear All” button.    You can delete a tab from the clear list by 
selecting the tab and then pressing the “Delete” button.

Leader: This section allows you to specify the type of leader (if any) you wish to use.    The leader is a 
repeated pattern which extends from the end of the text which precedes the tab to the tab position.    A 
leader is often used in a table of contents, for example.

Alignment: This section allows you to specify the alignment of the tab.    Left aligned tabs align the left 
edge of the text to the tab.    Right aligned tabs align the right edge of the text to the tab.    Center aligned 
tabs align the center of the text to the tab.    Decimal aligned tabs align the decimal point to the tab.    This 
is useful for creating columns of numbers.    The character which is considered to be the decimal point can 
be specified in the Edit | Preferences dialog box.

Set: Use this button to add a tab to the “Set Tabs At” list.    Enter the tab you wish to set in the edit field of 
the “Set Tabs At” list and click this button.

Clear: Use this button to add tabs to the “Clear Tabs At” list.    Enter the tab you wish to clear in the edit 
field of the “Set Tabs At” list and click this button.

Delete: Use this button to delete tabs from the “Set Tabs At” or “Clear Tabs At” lists.    Click on the tab you 
wish to delete in either list and then click this button.

Default Width: Use this button to specify the default tab width.

By default, the tabs are specified in the default units specified in the Window’s control panel, but you may 
specify them in inches, centimeters, or points by following the number with the letters "in", “cm”, or "pt" 
(e.g. 1.00in, 2.54cm, or 72.0pt).

Keyboard Shortcut

Tabs ALT + R, T.



Bullets
Format | Bullets

Use "Bullets..." to create bullet paragraphs.    Bullet paragraphs can begin with round, diamond, or 
character bullets.    The bullet appears on the left side of the paragraph.    WordExpress lets you control 
the size and color of the bullet, and also its position relative to the text.

Bullet Dialog Box

Type: Select the type of bullet desired.    The available types are round, diamond, or character.

Round: To create a round bullet, click on one of the standard size round bullets or enter a custom size in 
the "Size" field to the right.    The "Round" type button will be automatically selected for you.

Diamond: To create a diamond bullet, click on one of the standard size diamond bullets or enter a 
custom size in the "Diamond" field to the right.    The "Diamond" type button will be automatically selected 
for you.

Character: To create a character bullet, enter the ANSI character number in the "Character" field or select 
the character using the control to the right.    Select the desired the face name from the "Face Name" 
menu below, and enter the desired point size in the "Point Size" field.

Color: Select the desired bullet color from this menu of standard colors.

Horz. Pos: Specify the distance to the left of the paragraph at which you wish the bullet to appear.

Vert. Pos: Specify the vertical position relative to the default position at which you wish the bullet to 
appear.    A zero value results in the default position which is centered.    A positive value will move the 
bullet up and a negative value will move the bullet down.

Set Auto Bullet Command: Check this box if you want this bullet to be the default used for the auto 
bullet command.

Keyboard Shortcut

Bullet ALT + R, E.



Borders
Format | Borders

Use "Borders..." to create border lines around paragraphs or objects.    WordExpress lets you create 
several styles of borders, as well as controlling their placement relative to the text.    If text is selected then 
the Paragraph Border dialog box is displayed.    If an object is selected then the Frame Border dialog box 
is displayed.

Keyboard Shortcut

Borders ALT + R, O.



Lines
Format | Lines

Use "Lines..." to choose a line thickness and type for graphic objects you create with the drawing tools, as 
well as frame borders.    This command is only active when your are in object (pointer) mode.    However, 
this is the same dialog box that appears when you click the "Lines..." button from the Paragraph Border 
dialog box.

Lines Dialog

Type: Choose the line type desired.    You may choose to have no line, or a single or double line.

Thickness: Choose from one of the predefined line thicknesses, or enter any thickness in the 
"Thickness / Separation / Thickness" edit fields below.    If a single line has been selected, only the first 
thickness is used.    If a double line is selected, you may set the thickness of each line as well as the 
distance between lines.    By default, the thickness is specified in points, but you may enter the value in 
inches or centimeters by following the number with the letters "in" or "cm" (e.g. 1.00in or 2.54cm).

Keyboard Shortcut

Lines ALT + R, L



Shades
Format | Shades

Use "Shades..." to apply a shade or fill pattern to an object, frame, or paragraph background.

Shades Dialog Box

Shades: Click on one of the pre-defined shades or enter any custom shade value from 0 (white) to 100% 
(solid color).

Patterns: Click on one of the pre-defined fill patterns.

Foreground Color: If you have selected a shade, then this field specifies the color for the shade.    If you 
have selected a pattern, then field specifies the color to be used for the "black" portion of the pattern.

Background Color:    If you have selected a pattern, then this field specifies the color to be used for the 
"white" portion of the pattern.    If you have selected a shade, then this field a second color which is 
combined with the “Foreground Color” to produce the shade.

Blend: Specifies the type of blend desired (if any).    You can also click on the “Blend” button to bring up 
the Blend dialog box which gives you precise control over blends.    For a complete description of blends, 
refer to the description in the “Blend” dialog box.

Keyboard Shortcut

Shades ALT + R, S.



Section
Format | Section

Use "Section..." to set the number of columns, gutter width, column height, and line between columns for 
a section.    You can create section breaks via the "Section Break" command on the Insert menu.

Section Dialog Box

Number: Enter the number of columns for this section.    You may have between 1 and 8 columns.

Gutter: Enter the amount of space you want to have between columns.

Height: Enter the height of the column.    You may choose a fixed height or choose "Auto" in which case, 
the height of the columns will be determined by the amount of text, with the columns being automatically 
balanced.    You may also choose "Page Height" to make the column height equal to the entire page.

Line Between...: Click on this button to bring up the Lines dialog box which allows you to specify the line 
style of the line (if any) which is drawn between the columns.

Apply To: If you have text selected, you may choose to apply your changes to the selected text, the 
selected sections, or to the whole document.    If no text is selected, then you may apply your changes to 
the current section, from the cursor position to the end of the current section, or to the entire document.

Restart Auto Numbers: Click this option if you want the auto numbers (see Field in the Insert menu) to 
be restarted at the beginning of this section.

Break Page: Check this box if you wish to force a page break before this section.

Keyboard Shortcut

Section ALT + R, N



Chapter
Format | Chapter

Use "Chapter ..." to set up whether chapter number should be set or incremented, the numbering system 
for pages,    where the master page defines global settings etc.

Chapter Dialog

Chapter Number: You can specify that the chapter number be automatically set by incrementing the 
previous chapter number, or you can set the chapter number to a specific value.

Page Number: You can specify that the first page number of this chapter be automatically set by 
incrementing the last page of the previous chapter, or you can set the first page number to a specific 
value.

Start On Page: You can specify which page (relative to the start of the chapter) upon which the master 
page will be printed. For example, if you have a title page and you do not want your headers and footers 
to appear on the title page, you would set “Start On Page” to 2.    See Master Pages for more information.

Facing Pages: Check to use facing pages.    This allows you to have differing left and right margins for 
even and odd pages in order to accommodate binding of double sided documents.    If this option is 
checked, you will also have separate master pages for even and odd pages.    This makes it possible for 
you to have a different header on left and right pages, for example.

Inside Gutter: If you check “Facing Pages”, this value specifies the amount of extra margin required on 
the “inside” edge of the pages (that is the edge which would be bound for a double sided document).    
The “inside” edge of odd pages is the left edge, while the “inside” edge of even pages is the right edge.    
The left and right margins of odd and even pages will be adjusted automatically by this value.

Start On: Click “Right Page” if you want to force this chapter to always start on an odd numbered page.    
Click “Left Page” if you want to force this chapter to always start on an even numbered page.    Click 
“Either Page” if you do not care.

Keyboard Shortcut

Chapter ALT + R, R



Styles
Format | Styles

Format | Styles | Character Style 
Format | Styles | Paragraph Style 
Format | Styles | Load Style Sheet 
Format | Styles | Save Style Sheet 



Character Style
Format | Style | Apply Character Style

Click to get a dialog of available character styles. If you click on a style name then all highlighted text will 
adopt that style.

Keyboard Shortcut

Apply Character Style ALT + R, Y, C



Paragraph Style
Format | Style | Apply Paragraph Style

Click to get a dialog of available paragraph styles. If you click on a style name then all highlighted text will 
adopt that paragraph style.

Keyboard Shortcut

Apply Paragraph Style ALT + R, Y, P



Load Style Sheet
Format | Style | Load Style Sheet

A style sheet consists of all of the defined styles (both character and paragraph) defined for a document. 
When you load a style sheet from a template, the styles from that template are combined with the styles 
present in your document.    If the style already exists in your document, the style from the template will 
replace it.    If the style does not exist in your document, it will be added. 

Keyboard Shortcut

Load Style Sheet ALT + R, Y, L



Save Style Sheet
Format | Style | Save Style Sheet

A style sheet consists of all of the defined styles (both character and paragraph) defined for a document. 
When you save a style sheet to a template or a document, the styles from your document are combined 
with the styles present in the template.    If the style already exists in the template, the style from your 
document will replace it.    If the style does not exist in the template, it will be added. 

Keyboard Shortcut

Save Style Sheet ALOT + R, Y, S



Tools
Object    | Tools

The object tools menu has the same function as clicking on the object mode pointer. 

A list of tools appears to; place a text box into the document, place a picture frame into the document, 
create a table,    change text effects, add an OLE object, or draw various shapes.

Keyboard Shortcut

Tools ALT + O, T.



Properties
Object | Properties 

Use to change the properties of an object in the document.    The dialog box displayed depends on the 
object which is selected.    Click on one of the fields below to see information about a specific object type:

Text Frame 
Picture 
Table 
Text Effect 
OLE Object 
Line 
Rectangle / Rounded Rectangle 
Ellipse 

Keyboard Shortcut

Properties ALT + O, P.



Object
Object | Object

Use this option for any OLE object you may have inserted into your document. You can, for example, 
open the object with the program that created it for editing. 

This menu option is only available if you have highlighted an OLE object. See OLE for more information.

Keyboard Shortcut

Object ALT + O, O.



Edit Links
Object | Edit Links

Use this option to edit the links created to support OLE objects.

This option is only available when a linked OLE object is being used.

Keyboard Shortcut

Edit Links ALT + O, E.



Object Group
Object | Group

Use this option to group or ungroup objects so they may be manipulated as a unit.

To group objects, first select the set of objects you wish grouped.    To do this, switch to pointer mode and 
then press and hold the shift key while you click with the left button on each object.    As you do this you 
will see the object highlighted.    When you have all of the objects selected, choose the “Group” command 
from the “Object” menu.    The objects will now be grouped and will hence forth appear as if they were a 
single object.

To ungroup a grouped object, simply select the object and choose the “Ungroup” command from the 
“Object” menu.    The objects will now be separate.

Keyboard Shortcut

Group ALT + O, G.



Snap to Grid
Object | Snap To Grid

Use "Snap to Grid" to precisely position objects, frames, and tables to the grid increments you specified 
with the "Set Grid..." command.    A check mark next to this command indicates that it is active. 

Associated Topic: Set Grid 

Keyboard Shortcut

Snap to Grid ALT + O, R



Snap to Guides
Object | Snap to Guides

Use "Snap to Guides" to precisely position objects, frames, and tables to any guide lines you may have 
created in your document.    A check mark next to this command indicates that it is active.

You can create a guide with the mouse by clicking on the ruler bar (either horizontal or vertical) while in 
object mode and then dragging the mouse into the document.    A guide can be moved by clicking on the 
guide while in object mode and dragging with the mouse.    A guide can be deleted by clicking on the 
guide while in object mode and dragging it up to the ruler.

You can also create, move and delete guides via the "Edit Horz. Guides..." and "Edit Vert. Guides..." 
commands.

Associated Topics: Edit Horizontal Guides 
Edit Vertical Guides 

Keyboard Shortcut

Snap to Guides ALT + O, U



Lock Guides
Object | Lock Guides

Use this option to prevent guides being accidentally altered after you have set them.

Associated Topics: Edit Horizontal Guides 
Edit Vertical Guides 
Set Grid 

Keyboard Shortcut

Lock Guides ALT + O, L



Set Grid
Object | Set Grid

The Set Grid Dialog allows you to decide the horizontal and vertical distance on the square grid for 
aligning objects. Using the "Snap To Grid" check mark is used to activate this feature.

Additional Topic: Snap to Grid 

Keyboard Shortcut

Set Grid ALT + O, S.



Edit Horizontal Guides
Object | Edit Horz. Guides

Use "Edit Horz. Guides..." to add, delete, and move horizontal guide lines.

Edit Horizontal Guides Dialog Box

To create a new guide, enter the vertical position of where you wan the new guide in the "Position" edit 
field and click "Add".    The new guide will be added to the list of guides in the list box below.    By default, 
the position is specified in centimeters, but you may specify it in inches or points by following the number 
with the letters "in" or "pt" (e.g. 1.00in or 72.0pt).

To delete an existing guide, click on the guide to be deleted (or enter its position in the edit field) and click 
"Delete".

To move an existing guide, click on the guide to be moved, enter a new horizontal position and then click 
"Move".

Editing horizontal guides with the mouse

To add a horizontal guide line with the mouse, change to object mode, click anywhere within the 
horizontal ruler and drag into the document. When you release the mouse button, a guide line appears at 
that position. 

You can move a guide line by clicking and dragging it.

To delete a horizontal guide line with the mouse, click it and drag it back to the horizontal ruler.

Keyboard Shortcut

Edit Horizontal Guides ALT + O, H.



Edit Vertical Guides
Object | Edit Vert. Guides

Use "Edit Vert. Guides..." to add, delete, and move vertical guide lines.

Edit Vertical Guides Dialog Box

To create a new guide, enter the horizontal position of where you wan the new guide in the "Position" edit 
field and click "Add".    The new guide will be added to the list of guides in the list box below.    By default, 
the position is specified in centimeters, but you may specify it in inches or points by following the number 
with the letters "in" or "pt" (e.g. 1.00in or 72.0pt).

To delete an existing guide, click on the guide to be deleted (or enter its position in the edit field) and click 
"Delete".

To move an existing guide, click on the guide to be moved, enter a new horizontal position and then click 
"Move".

Editing vertical guides with the mouse

To add a vertical guide line with the mouse, change to object mode, click anywhere within the vertical 
ruler and drag into the document. When you release the mouse button, a guide line appears at that 
position. 

You can move a guide line by clicking and dragging it.

To delete a vertical guide line with the mouse, click it and drag it back to the vertical ruler.

Keyboard Shortcut

Edit Vertical Guides ALT + O, V.



Field
Insert | Field

Use "Field..." to bring up the "Insert Field" dialog box which allows you to insert a special field into your 
document. 

Insert Field Dialog Box

Field Type: Choose the type of field you desire as follows:

Auto Number: A field which generates an number is inserted.    You may choose either "Legal" (e.g. 1., 
1.1, 1.1.1, etc.), or "Outline" (e.g. I, A, i, a, etc.) numbering.    The level is controlled by the "Outline Level" 
setting in the paragraph attribute (see "Paragraph" command under the Edit menu).

Create Date: The date on which the document was created is inserted.    You may choose from any of a 
number of date formats, or you may click the "Settings..." button which will display the "Date/Time Format" 
dialog box which allows you to enter your own custom format.

Create Time: The time at which the document was created is inserted.    You may choose from any of a 
number of time formats, or you may click the "Settings..." button which will display the "Date/Time Format" 
dialog box which allows you to enter your own custom format.

File Name: The file name of the document is inserted.    You may choose either the full path or only the 
base file name.

Merge Field: A merge field is inserted.    If you have a database selected, the "Data" list box will contain a 
list of the available fields from that database.    Otherwise, the list will contain "Field One", "Field Two", 
etc., which represents the fields of the database in the order they are defined.    You may click on the 
"Settings" button to display the "Set Merge File" dialog box, which allows you to select the database to 
use.

Page: Inserts the current page number.    This field is most useful in headers or footers.

Print Date: The date on which the document was last printed is inserted.    This field is always updated 
each time you print your document.    You may choose from any of a number of date formats, or you may 
click the "Settings..." button which will display the "Date/Time Format" dialog box which allows you to 
enter your own custom format.

Print Time: The time at which the document was last printed is inserted.    This field is always updated 
each time you print your document.    You may choose from any of a number of time formats, or you may 
click the "Settings..." button which will display the "Date/Time Format" dialog box which allows you to 
enter your own custom format.

User Information:  You may insert any of the fields from the "User " dialog box (See Preferences ).

Keyboard Shortcut

Field ALT + I, E



Merge Field
Insert | Merge Field

Use for placing information from a database into your document. You can use the feature "blind" without 
having a database set but in this mode of operation you would simply be placing something called "Field 
One" etc. into the document.

Insert Merge Field Dialog

This dialog lists fields in a box that you can highlight with a mouse click. 

Merge File: The merge file button is perhaps the most important. If you click on this you get a standard 
Windows dialog allowing you to browse for your database. The database type selection bar allows you to 
choose the format of the database. If your database has meaningful field names then once it selected 
those will be displayed by WordExpress.

Insert: Click on insert to place the current field into the current document.

Close: To close the dialog and return to the document.

Note: To print the contents of the fields you have to do a merge print from the File | Print menu.

Associated Topics: CSV 
DBF 
Print 

Keyboard Shortcut

Merge Field ALT + I, M.



Header
Insert | Header

WordExpress makes it easy for you to insert Headers in your document.    Headers are a special type of 
text frame that are repeated on every page of the document.    Headers appear at the top of the page 
between the page edge and the top margin.    You can format text and fields contained in headers    just 
like other text frames.

To insert a header    into your document:

1. Choose "Insert Header"    from the Insert menu. A text frame is automatically created between the 
left and right margins.    The initial width of the header depends on the position of your left and right 
margins.

2. Type the text that you want to appear in the header into the frame.

3. Format the header    text just as you would other text.

4. Insert any fields into the header    - such as auto page numbers, print date, etc. - using the "Insert 
Field..." command under the Insert menu.

5. Resize the header    horizontally like you would any other text frame;    you can only resize it 
vertically by adding lines of text or pressing Enter.

Once a header    has been inserted, the command changes to "Go to Header". Choosing this command 
will place the cursor into the header.

Associated Topics: Footer 
Field 

Keyboard Shortcut

Header ALT + I, H.



Footer
Insert | Footer

WordExpress makes it easy for you to insert    Footers in your document.      Footers are a special type of 
text frame that are repeated on every page of the document.    Footers appear the bottom of the page 
between the page edge and the bottom margin.    Footers are the ideal place to include automatic page 
numbers, date, time, and several other insert fields.    You can format text and fields contained in    footers 
just like other text frames.

To insert a    footer into your document:

1. Choose "Insert Footer"    from the Insert menu. A text frame is automatically created between the left 
and right margins.    The initial width of the footer depends on the position of your left and right 
margins.

2. Type the text that you want to appear in the footer into the frame.

3. Format the footer    text just as you would other text.

4. Insert any fields into the footer    - such as auto page numbers, print date, etc. - using the "Insert 
Field..." command under the Insert menu.

5. Resize the footer    horizontally like you would any other text frame;    you can only resize it vertically 
by adding lines of text or pressing Enter.

Once a footer    has been inserted, the command changes to "Go to Footer". Choosing this command will 
place the cursor into the footer.

Associated Topics: Header 
Field 
Footer 

Keyboard Shortcut

Footer ALT + I, F.



Bookmark
Insert | Bookmark

Use insert bookmark to leave electronic bookmarks in your text. You can set many bookmarks all with 
unique names so you can jump to a particular point in your document with ease.

This feature is best used with long documents.

Insert Bookmark Dialog

To insert a bookmark simply type it's name in the space provided. Bookmarks can be deleted by 
highlighting the bookmark with a mouse in this dialog and clicking on the delete button.

You can jump to a bookmark by using the "Go To" entry on the edit menu. 

Associated Topic: Go To 

Keyboard Shortcut

Bookmark F5



Symbol
Insert | Symbol

Use this menu option to insert special characters that normally do not appear on the keyboard. If you pick 
this option a grid of characters appears. Simply press the insert button to place the current highlighted 
character into your document.

Note: You can change to other character sets by selecting the down arrow in the bottom left corner of the 
grid.

Keyboard Shortcut

Symbol ALT + I,Y.



Footnote
Insert | Footnote

Use the footnote feature to place a footnote in the text. Footnoting is particularly important where you 
have to note the sources of the statements or quotations you use in a document. Typically a footnote is 
sequentially numbered. 

Insert Footnote Dialog

Footnote Marker: This allows you to specify a particular number to start footnote references from. The 
automatic default starts at number 1.

Options: The options button allows the following.

Numbering: Whether to restart on each page or not.

Line Separator Margin:  The separation of the main text from the note.

Position: Should the footnote appear at the bottom of a page, at the end of a chapter or as a 
bibliography at the end of the whole document.

Keyboard Shortcut

Footnote ALT + I, N.



Goto Footnote
Insert | Goto Footnote

Use this to locate a footnote. If there are no footnotes in a document this option will not be available. 

Keyboard Shortcut

Goto Footnote ALT + I, G.



Break
Insert | Break

Insert | Break | Column Break 
Insert | Break | Section Break 
Insert | Break | Page Break 
Insert | Break | Chapter Break 



Column Break
Insert | Break | Column Break

Use this option to insert a column break. 

Keyboard Shortcut

Column Break CTRL + SHIFT + ENTER



Section Break
Insert | Break | Section Break

Use this option to insert a section break and start a new section.

Keyboard Shortcut

Section Break ALT + I, R, S



Page Break
Insert | Break | Page Break

Use this option to insert a page break and start a fresh page.

Keyboard Shortcut

Page Break CTRL + ENTER



Chapter Break
Insert | Break | Chapter Break

Use this option to insert a chapter break and start a new chapter.

Keyboard Shortcut

Chapter Break ALT + I, R, A



Picture
Insert | Picture

Use this option to insert a picture at the cursor. The "New Picture" dialog box will be displayed which 
allows you to enter the name of the picture to import.

This command differs from the Object menu command to create a picture in that the picture is inserted 
into the text rather than attached at an absolute position on the page.    In this way, the picture will move 
with the surrounding text.    Pictures may be inserted anywhere in the document.

Keyboard Shortcut

Picture ALT + I, I.



Table
Insert | Table

Use "Table..." to insert a table into the text at the current cursor position or into a table cell.    The "New 
Table" dialog box will be displayed which allows you to enter the number of rows and columns for the 
table.

This command differs from the Object menu command to create a table in that the table is inserted into 
the text rather than attached to an absolute position on the page.    In this way, the table will move with the 
surrounding text.    A table may not be inserted into a text frame.    If the cursor is in a table, then this 
command will create a sub-table within the current cell of the table.

Keyboard Shortcut

Table ALT + I, T.



Edit Rows
Table | Edit Rows

Use "Edit Rows" to edit the attributes of rows of a table.    The attributes of all of the currently selected 
rows will be changed.    If no rows are selected, the attributes of the row currently containing the cursor 
will be changed.

Edit Table Row Dialog Box

# Columns: Enter the number of columns in the selected rows.

Min. Height: Enter the minimum height for each of the selected rows.    The height of the row is 
determined by the height of the largest cell in the row, subject to the limitation that it not be smaller than 
this minimum.

Keep Together With Next Row: Click this option if you do not want a page break to occur between this 
row of the table and the next.    This option is only available for tables that were inserted into the text using 
the "Table..." command under the Insert menu, i.e., it is not available for tables created using the table 
tool in object mode.

Break Page At Row: Click this option if you want to force a page break before this row.    If more than one 
row is selected, page breaks are inserted between each of them.    This option is only available for tables 
that were inserted into the text using the "Table..." command of under Insert menu, i.e., it is not available 
for tables created using the table tool in object mode.

Keyboard Shortcut

Edit Rows ALT + T, R.



Edit Cells
Table | Edit Cell

Use "Edit Cells..." to edit the attributes of cells in a table.    The attributes of all selected cells will be 
changed.    If no cells are selected then the attributes of the cell currently containing the cursor will be 
changed.

Edit Table Cell Dialog Box

Margins: Enter the left, right, top, and left margins.    The margins represent the distance from the edge of 
a cell to the text.

Width: Enter the width of the cell.    If the "Auto Width" option is selected, then the width of the cell is 
determined by the width of the text within the cell and this field is grayed.

Auto Width: Click this option if you wish the width of the cell to be determined by the width of the text 
within the cell.

Right Align: Click this option if you want the cell to be right aligned.    This option is only useful when 
used in conjunction with the "Auto Width" option.    It does not right align the text in the cell, but rather the 
cell itself.

Align Baselines: Click this option to align the baselines of all of the cells in a row with the "Align 
Baselines" option set.

Changing cell width with the mouse

You can also change the width of selected cell columns with the mouse: switch to text mode, then position 
the I-beam over a column border.    The pointer changes to    which lets you move column borders.    Click 
and drag to the right or left to increase or decrease the column width.    If cells are selected, then only the 
width of the selected cells are changed.    If no cells are selected then the widths of all cells in the column 
are changed.

Keyboard Shortcut

Edit Cells ALT + T, C.



Insert Rows
Table | Insert Rows

Use "Insert Rows" to insert rows into a table.    If there are rows currently selected, then a number of rows 
equal to the number currently selected will be inserted before the first selected row.

If no rows are currently selected, then the "Insert Rows" dialog box will be displayed.    Enter the number 
of rows you wish to insert.    The rows will be inserted before the row which currently contains the cursor.

Keyboard Shortcut

Insert Rows ALT + T, I.



Insert Columns
Table | Insert Columns

Use "Insert Columns" to insert columns into a table.    If there are columns currently selected, then a 
number of columns equal to the number currently selected will be inserted before the first selected 
column.

If no columns are currently selected, then the "Insert Columns" dialog box will be displayed.    Enter the 
number of columns you wish to insert.    The columns will be inserted before the column which currently 
contains the cursor.

Keyboard Shortcut

Insert Columns ALT + T, N.



Delete Cells
Table | Delete Cells

Use "Delete Cells" to delete the currently selected cells.    If no cells are selected, this command is 
grayed.    "Delete Cells" differs from the "Cut Cells" command on the Edit menu in that the deleted cells 
are not copied to the clipboard.    You can also delete cells by pressing the delete key when cells are 
selected.

Keyboard Shortcut

Delete Cells ALT + T, D.



Select Table
Table | Select Table

Use "Select Table" to select the entire table currently containing the cursor.

Keyboard Shortcut

Select Table ALT + T, T.



Select Rows
Table | Select Rows

Use "Select Rows" to select entire rows of a table.    If no cells are currently selected then the row    
containing the cursor is selected.    If cells are selected, then the all of the rows which contain the selected 
cells are selected.

Keyboard Shortcut

Select Rows ALT + T, S.



Select Columns
Table | Select Columns

Use "Select Columns" to select entire columns of a table.    If no cells are currently selected, then the 
column which contains the cursor is selected.    If cells are selected, then all of the columns which 
contains the selected cells are selected.

Keyboard Shortcut

Select Columns ALT + T, E.



Set Merge File
Utilities | Set Merge File

Use "Set Merge File" to specify the database which is to be used merging.    When the document is 
printed, you may specify that a "Merge" is to take place.    In this case, the document will be printed once 
for each record in the database (or for the range of records specified).    Each time the document is 
printed, each merge field (see the "Field" command on the Insert Menu) in the document will be replace 
by the associated field from a record of the database.

Set Merge File Dialog Box

List Files of Type: Select options from this menu to tell WordExpress the type of database you want to 
merge: Windows/ANSI Comma Delimited, DOS/PC-8 Comma Delimited, Windows/ANSI dBASE or 
DOS/PC-8 dBASE.    The type you choose here determines the available files in the file list.

Use first record for field name: Check this option if you wish to use the first record of the database for the 
field names.    This is particularly useful for Comma Delimited databases which do not have field names.

Select the drive and directory where you want WordExpress to look for databases from the Drives and 
Directories list boxes.

Keyboard Shortcut

Set Merge File ALT + U, M



Insert Index Entry
Utilities | Insert Index Entry

Use this option to add the highlighted text to an index. 

Index Entry Dialog

The index entry dialog allows you to add and remove index entries, rename an entry and a check box 
tells WordExpress to index all occurrences of a word or words. Use this last option with caution to avoid 
very large indexes!

You can create a two level index by separating the two levels by a semicolon.    For example if you insert 
five index entries as follows:

Alpha - on page 1
Beta;One - on page 2
Beta;Two - on page 3
Beta;Three - on page 4
Gamma - on page 5

The following index will be generated:

Alpha 1
Beta

One 2
Two 3
Three 4

Gamma 5

Associated Topics: Generate Index 
Generate Table of Contents 

Keyboard Shortcut

Insert Index Entry ALT + U, I.



Generate Index
Utilities | Generate Index

Use this to generate an index. 

Generate Index Dialog

The Generate Index Dialog allows you to customize your index. You can give your index alphabetic 
lettering,    a blank line between sections or no breaks at all. You can also index by chapter. 

Associated Topics: Insert Index Entry 
Generate Table of Contents 

Keyboard Shortcut

Generate Index ALT + U, G.



Generate Table of Contents
Utilities | Generate Table of Contents

Use this option to generate a Table of Contents. The Table of Contents is based upon the outline levels on 
which chapter and section headings were developed during the writing of the document. 

Table of Contents Dialog

The dialog allows you to specify the range of outline levels that will be included in the compilation of the 
Table of Contents. Thus choosing "1 through 9" will cause the outline levels from 1 to 9 to be used as 
Table of Contents entries. 

Associated Topics: Outline 
Insert Index Entry 
Generate Index 

Keyboard Shortcut

Generate TOC ALT + U,    C.



Thesaurus
Utilities | Thesaurus

Use WordExpress' built-in Thesaurus to add a wider range of words to your documents.

Thesaurus Dialog

Word: Specifies the work to look up.    You place the caret in a word before choosing the “Thesaurus” 
command, this field will be filled with that word.    You can enter a new word and click “Lookup” or choose 
from a history list by using the drop down.

Synonyms: Displays a list of synonyms.    You can double click on a synonym to move it to the “Word” 
field.    A new list of synonyms will then be generated based on this new word.    Click “Replace” if you 
wish to have your word replaced by this synonym.

Usages: Displays the possible usages of this word.    You may click on a different usage which will 
generate a different list of synonyms.

Definition: Displays a brief definition of the word in the “Word” field.

Replace: Click this button to replace the original word in you document with the word currently in the 
“Word” field.

Lookup: Click this button to look up the word currently in the “Word” field.

Keyboard Shortcut

Thesaurus F8



Spell Check
Utilities | Spell Check

Use WordExpress' spell check to remove any typing errors from your documents.    You will first be asked 
what portion of the document you wish to check via the Spell Check Start dialog box.    If a misspelled 
word is found, you can correct using the Spell dialog box.

Keyboard Shortcut

Spell Check F7



Word Count
Utilities | Word Count

Use the word count to get an up to the moment analysis of number of words, characters, lines, 
paragraphs    and pages in your document.

Keyboard Shortcut

Word Count F6



Fit In One Less Page
Utilities | Fit In One Less Page

Use this function to tell WordExpress to try and fit the document in one less page than its current length.    
This is accomplished by scaling all of the fonts within the document by a percentage of their actual size.

You can also use this option to return the document to normal, or enter any arbitrary scale factor.

Keyboard Shortcut

Fit In One Less Page ALT + U, F



Customize Speed Tools
Utilities | Customize Speed Tools

Use "Customize Speed Tools..." to configure the speed tool palette.    You can choose which speed tools 
appear on the palette, as well as their order.    The "Customize Speed Tools" dialog box is displayed:

Customize Speed Tools Dialog Box

Tools: Select from this list of tools to add to or remove from the tool palette.

Default: Click this button to install the default set of tools.

Add: Click this button to add the currently selected tool to the palette.    If the tool is currently on the 
palette, this button will be grayed.

Add All: Click this button to add all of the tools to the palette.

Remove: Click this button to remove the currently selected tool from the palette.    If the tool is not 
currently on the palette, this button will be grayed.

Remove All: Click this button to remove all of the tools from the palette.

Position: Choose the palette's position.    The palette may be positioned along the top, bottom, left edge 
or right edge, or may be floating.

Done: Click this button when all modifications are complete.

Configuring the tool palette with the mouse

Display the "Customize Speed Tools" dialog box either by choosing "Customize Speed Tools..." from the 
Utilities menu or double clicking on the speed tools palette.

You can then add tools to the palette with the mouse by clicking on the tool icon below the "Add All" 
button and dragging the tool over to the palette.      You can remove tools from the palette with the mouse 
by clicking on any tool on the palette and dragging it off the palette.    You can re-arrange the order of tools 
on the palette by clicking on any tool on the palette and dragging it to a new position.

Click "Done" when all modifications are complete.

Keyboard Shortcut

Customize Speed Tools ALT + U, U.



Cascade
Window | Cascade

Cascade

Arranges all non-minimized document windows in a cascade fashion starting in the upper left corner of 
the workspace and moving down and to the right



Tile
Window | Tile

Tiles all non-minimized documents so all are visible simultaneously



Arrange Icons
Window | Arrange Icons

Arrange Icons

Arranges all the icons which represent minimized documents.



Close All
Window | Close All

Closes all open documents



Open Windows
Window | 1 Document

The Window menu list all open documents at the end of the menu.    Clicking on one of these documents 
will bring that document window to the front.



Tool Tips
Help | Tool Tips

This function allows you to turn “Tool Tips” on or off.    Tool tips are the small pop-up information boxes 
which appear whenever you pause the mouse over a button on the control strip or speed tools.    If a 
check mark appears next to the menu item, then “Tool Tips” are enabled.



Tips of the day
Help | Tips of the day

This function allows you to turn “Tips of the day” on or off.    If enabled, the tip of the day is displayed each 
time you start WordExpress.    If a check mark appears to the left of the menu item, the “Tips of the day” 
are enabled.



About
Help | About

This function displays a window which shows the copyright and version information for WordExpress.



Toggle Ruler Style
This function toggles the ruler style between the old style (version 1.1) and the new 3D style.



Hide Horizontal Ruler
This function allows you to hide the horizontal ruler.    You can turn the ruler back on by using the “View” 
tab of the Preferences dialog box found under the Edit | Preferences Menu.



Hide Vertical Ruler
This function allows you to hide the vertical ruler.    You can turn the ruler back on by using the “View” tab 
of the Preferences dialog box found under the Edit | Preferences Menu.



Hide Strip
This function allows you to hide the control strip, speed tools, or status strip.    You can turn the strips back 
on by using the View | Toolbars function on the “Edit” menu.



Position Strip At Top
This function allows you to position the control strip or speed tools along the top edge of the window.



Position Strip At Bottom
This function allows you to position the control strip or speed tools along the bottom edge of the window.



Position Strip At Left
This function allows you to position the speed tools along left edge of the window.



Position Strip At Right
This function allows you to position the speed tools along the right edge of the window.



Position Strip As Floating
This function allows you to position the control strip or speed tools as a floating palette.



Edit OLE Object
This function allows you to run the application which created the selected OLE object in order to edit it.



Convert OLE Object
This function allows you to convert an OLE object to another type.



Purchasing Information
The Registered Version of WordExpress can be obtained by contacting the vendors listed below.    Click 
on the vendors name to display the information for that vendor.    You can then use File/Print/Topic to print 
the order form.

Vendor:
MicroVision Development, Inc. United States
The Thompson Partnership United Kingdom
WindowShare SARL France
BroCo Software Nederland
Pro-Soft Denmark

Thank you for using MicroVision products.



MicroVision Development, Inc.    (United States)
Use File/Print/Topic from the menu to print this form.

How to Order
You can order directly from MicroVision Development using MasterCard, VISA, American Express or 
check drawn on a US Bank.    For immediate service using a credit card:

(800) 998-4555 Toll Free (U.S. Orders only)
(619) 438-0305 Voice
(619) 438-7406 Fax
75201,2104 CompuServe E-Mail

To order by mail with a check or credit card, please send your order to:

MicroVision Development, Inc.
P.O. Box 3010
Carlsbad, CA    92009
USA

Order Information:

      Copies of WordExpress    @ $49.95 $_____________

      Copies of WordExpress International @ $69.95 $_____________

      Additional Languages (please specify) @ $20.00 $_____________

CA residents add sales tax $_____________

Shipping US or Canada $5.00 (Intl $16.00) $_____________

Total: $_____________

Platform: Windows 3.x Window 95

Spell Check: Am. English Intl. English German French

Spanish Italian Danish Dutch

(WordExpress International please select three languages)

User Information:

Name _______________________________________________

Company ____________________________________________

Address _____________________________________________

Address _____________________________________________

City ________________________________________________

State _______________________________________________

Country ________________________    Zip Code ____________

Telephone ___________________________________________

Credit Card Type ______________________________________

Credit Card Number ____________________________________

Expiration Date ________________________________________
(When ordering with a credit card, be sure to include the cardholder's name and address)



The Thompson Partnership (United Kingdom)
Use File/Print/Topic from the menu to print this form.

You can order from The Thompson Partnership by payment with cheque or credit card.    The credit cards 
accepted are: MC, Visa, Diners Club, and American Express. 

Telephone Orders: 44 (0) 1889 564601
Fax Orders: 44 (0) 1889 563219
Internet Orders: sales@ttp.co.uk
Internet Support: support@ttp.co.uk

Please use this form when ordering by fax or mail:

Name ________________________________________________

Company _____________________________________________

Address ______________________________________________

Address ______________________________________________

Town ________________________________________________

City _________________________________________________

Country _______________________    Postal Code ___________

Telephone ________________________________

Credit Card Type __________________________

Credit Card Number _______________________

Expiration Date ___________________________

Platform: Windows 3.x Window 95

Spell Check: Am. English Intl. English German French 

Spanish Italian Danish Dutch

(WordExpress International please select three languages)

____ Copies of WordExpress @ £39.00 £____________

____ Copies of WordExpress International @ £55.00 £____________

____ Additional Languages @ £15.00 £____________

V.A.T.    @ 17.5% £____________

Shipping and Handling £3.00

Total: £____________

Make cheques or EuroCheque payable to: The Thompson Partnership.
(Be sure your card number is on the reverse of the cheque)

Mail to:
The Thompson Partnership
Church Croft
Bramshall,
UTTOXETER
Staffs, England
ST14 5DE



WindowShare SARL (France)
Faites FICHIER|IMPRIMER LA RUBRIQUE pour imprimer le bon de commande

Paiement par chèque bancaire ou postal, eurochèque ou
carte de crédit (MasterCard et Visa).

Téléphone : +33 87 30 85 57
Télécopie : +33 87 32 37 75
Minitel : 3615 WinShare, boutique Licenseware

Nom ________________________________________________
Société ______________________________________________
Adresse ______________________________________________
Adresse ______________________________________________
Code Postal ___________Ville    ___________________________
Pays _______________________ 

Téléphone ________________________________
Numéro de carte de crédit ________________________________
Date d'expiration _____________/______________

Platform: Windows 3.x Window 95

Dictionnaires orthographiques :
 Am. English Intl. English Deutsch Français

Espanol Italiano Dansk Nederlandse
WordExpress International est livré avec trois langues. 
Merci d'indiquer votre sélection en rayant les mentions inutiles.

____ WordExpress à 399 FF TTC ____________
____ WordExpress International à 549 FF TTC ____________
____ Langue supplémentaire à 149 FF TTC ____________

Total : ____________
(Port inclus et TVA 18.6 % incluse)

Adresser ce bon de commande à :
WindowShare SARL
BP 2078
57051 - METZ cedex 2



Pro Soft (Denmark, Norway, Finland and Sweden)
Receives registrations for WordExpress from Denmark, Norway, Sweden and Finland
Use File/Print/Topic from the menu to print this form.

Name: ________________________________________________

Evt. company: ________________________________________________

Address: ________________________________________________

Address: ________________________________________________

Zipcode: ________________________________________________

City: ________________________________________________

Phone: _____________________ Fax: ______________________

*)   Customers in Sweden and Finland with a local VAT Number (SE, FI), will not have 
to apply VAT (MOMS) 25%, if you add your VAT-number in line 13 below.

**)  Norwegian customers will have to pay local MOMS (23 %) at the import plus a 
handling-fee to norwegian customs-authorities.

WHAT WE SEND TO YOU:
The registered packages of WordExpress consist of I. Registered version on 3.5" 1.44 
MB disks, II. Full description of the program in a professional manual.

Country: Denmark Sweden/Norway Finland

Item / Valuta: DKR. DKR. DKR.

[ ] 1. WordExpress, Danish dict. 420,00 420,00 420,00

[ ] 2. WordExpress, Int. Eng. dict. 420,00 420,00 420,00

[ ] 3. WordExpress Int. Edit. 570,00 570,00 570,00

3.1 Please indicate the 3 languages 
ordered for the Int. Ed. below

[ ] 4. Extra dict. dkr. 150,00 / pcs ___,__ ___,__ ___,__

4.1 Please indicate the languages 
ordered below

[ ] 5. Shipping & Handling 28,00 60,00 60,00

[ ] 6. If not prepaid, COD 18,00 20,00 20,00

[ ] 7. Check exchange (50,00) ___,__ ___,__ ___,__ 

8. Total before VAT (MOMS) ___,__ ___,__ ___,__

9. MOMS (25%) of the above ___,__ ___,__ See above **

10. Grand total ___,__ ___,__ ___,__

Payment:

[ ] 11.  Prepaid to danish giro account 406 2140, date:  ___/___ 199

[ ] 12. Send the program(s) with "postforskott" / postopkrav. (Add line 6 Above in 
total).

[ ] 13. Swedish or finnish VAT-no.: _________________________________ (No VAT in 
line 9 above).



[ ] 14. Check. If you from Norway, Sweden or Finland prefer payment by check, please 
also add dkr. 50,00 in line 7 above, that is what the bank claims to handle 
the check.

Any other fee connected to the money transfer has to be paid by the customer.

Dict.: [ ] Danish [ ] Am. english [ ] Intl. english [ ] German
[ ] Spanish [ ] Italien [ ] French [ ] Dutch

Windows: [ ] Windows 95 [ ] Windows 3.x

All prices above is in danish kroner.
Call, mail, upload, fax or e-mail to:
Pro Soft, Benloese Skel 4 G, DK-4100 Ringsted, Denmark.
Tlf.:          (+45) 53 61 90 42. Monday-friday 10:00 - 16:30.
Fax.:          (+45) 53 61 93 91, 24 hours.
BBS:           (+45) 57 67 17 47, 24 hours, free access, (28.800, 8,N,1)
Internet:      100065.1744@COMPUSERVE.COM
Compuserve:    100065,1744.
All orders are send same day as payment is received or same day as the order are 
received if send by
"postforskott" / postopkrav. Sorry, no creditcards.



BroCo software ( Nederland en België )
Selecteer "Bestand / Onderwerp afdrukken" vanaf de menubalk om dit formulier te printen.

Telefonische bestellingen: 035-6026650
Fax: 035-6014012
Support: 035-6029596

Gebruik A.U.B. dit formulier bij schriftelijke bestellingen.

Naam: ___________________________________________________ 

Bedrijfsnaam: ___________________________________________________ 

Adres: ___________________________________________________ 

Postcode: ___________________________________________________ 

Plaats: ___________________________________________________ 

Land: ___________________________________________________ 

Telefoon: ___________________________________________________

____ Kopieen van WordExpress @ ƒ 119,00 ƒ____________

____ Kopieen van WordExpress International @ ƒ 169,00 ƒ____________

____ Aanvullende talen                                          @ ƒ49,00 ƒ____________

Verzendkosten bij vooruitbetaling ƒ                7 , 5 0

Verzendkosten bij remboursement ƒ          1 2 , 5 0

Totaal: ƒ____________

Windows: Windows 3.x Windows 95

Spelling checker: Am. Engels Int. Engels Duits Frans

Spaans Italiaans Deens Nederlands

(Selecteer drie talen voor WordExpress International)

Wijze van betaling: (aankruisen wat van      toepassing is)

t.n.v. BroCo Software Soest 

[    ] Overmaking op bankrekening:            37.99.42.844 

[    ] Overmaking op girorekening:                  28.39.530 

[    ] Onder rembours (*)    (fl. 12,50 verzendkosten)

[    ] D.m.v. bijgevoegde betaalcheque (vergeet A.U.B. uw pasnummer niet!)

[    ] EuroCard / MasterCard of VISA

Kaartnummer    : ________.________.________.________

Vervaldatum    : _______________________
  
Datum: _________________                      Handtekening: __________________________



Zend dit formulier aan:                                      of FAX naar: 035-6014012
BroCo software 
Postbus 446 
3760 AK    SOEST
Nederland

 



Hints and Tips

Moving from general word processing to producing large reports, mail merges or even your first novel 
requires techniques that are beyond the scope of a reference guide. In fact they are the kind of things you 
mostly learn by experience of using a program.

Below you will find advice that we provide from our experience. We also explain answers to some of the 
"How do I ...." type questions that occasionally confront you in WordExpress. 

How Do I ...... ?

Address a letter ? 
Create a mail merge ? 
Delete A File 
Use a dbf file ? 

Other Topics

Master Pages 
Outlining 



How do I create a mail merge ?
Mail merges are one of the more common tasks in an office. You need to write to a number of people 
because they are overdue with a payment or maybe you want to follow-up on a sales contact.

WordExpress calls this kind of operation "merge printing". Other word processors call it "mail merge". 
Whatever the name what we mean is taking a list of names and addresses, usually created with one 
program, and getting WordExpress to incorporate those individuals' details into a letter. 

The first stage of a successful "merge print" is to know what data you have. Typically most offices have a 
database program to manage their lists. WordExpress can read data in two of the most popular formats - 
DBF and CSV. If you don't know what these formats are then please turn to our on-line glossary for a full 
explanation. 

Whichever format your data is in each element is referred to as a "field".    So someone's first name will be 
a field and their surname another and so on. What you have to do is know the order of the fields so you 
can place it in a WordExpress document. Your database program probably has a facility for listing how the 
data is laid out. 

Use your database program to create a DBF or CSV data file. Make a note of where the file is because 
you are going to be using it later.

Now start WordExpress. Begin to write your letter. Where the letter will include an item from the database 
use INSERT | MERGE FIELD followed by the field. When you insert your first merge field remember to 
tell WordExpress where it is going to get the data from by clicking on the Merge File button and finding 
the data file you created with your database program.

Once your document is complete you should save it. When you print the document click on the merge 
button and watch the fields of data get inserted into the final printout. Once you have done your first 
merge print you will see how it works. Don't worry if you have made a mistake - just go back and edit the 
document. 

Note: If any of these concepts is totally alien to you then you might need some extra help with 
understanding how databases work etc. Unfortunately this additional information is beyond the scope of 
this help file. 



How do I use a dbf file ?

A DBF file is simply a file using the dBase file format. This is a popular format used by many applications. 

WordExpress uses DBF files for mail merges - what we call "merge printing". To use a DBF file you just 
need to know what character set is the data based on (ASCII or Windows ANSI) and where the file is. 
After that simply follow the instructions about how to create a mail merge.

Associated Topic: How do I Create a mail merge ? 



How do I address a letter ?
WordExpress can automatically prepare an address heading at the top of your documents using your 
address and today's date. 

This is done easily using the following steps:

1. Start a normal document by using FILE | NEW. Use the normal template. Don't save the document.

2. Decide where you want to place your address details. Typically, for normal letters, you would tab to 
the right hand side of the screen first.

3. From the INSERT menu choose FIELD and then USER FIELD. User Fields are the name and 
address details you type under EDIT | PREFERENCES. WordExpress normally asks you to fill 
these details in when the program first starts.

4. You can now place "user fields" into the document. Click on the specific field to insert it. When you 
have completed filling in the fields you require and (optionally) adding the date field you have 
basically created a letter heading.

5. Save the file as a TEMPLATE. This will mean that you can use this template as the basis for future 
letters. Templates must be saved in the template directory.

Note: For information about templates please see the Glossary section. 



How do I delete A File
There are several ways to delete a WordExpress document. 

1. If you are familiar with the underlying DOS operating system that works from Windows then simply 
click on the MSDOS Prompt icon and delete the file.    WordExpress documents have the extension 
WD2 and templates have the extension WT1

2. If you are familiar with Windows then simply click on File Manager (or Explorer in Windows 95) and 
delete the file. 

3. You can also delete files from within WordExpress. Use the File Manager function from the file menu 
and locate the files you wish to delete. Then click on the delete button.

Bear in mind that if you delete a file that has been used recently it will still be listed on the "history" of 
recently opened files but it will not load if you click on that file. If you get an error "Access Denied" when 
trying to delete a file it is likely to be already opened by another application or another user on your 
network    - if you are connected to a network. Do not proceed with the file deletion if you get an "Access 
Denied" error.

For more information about the history list see History 



Outlining
Outlining is a common techniques used in word processors costing many times the price of WordExpress.

The idea is that you create a skeleton or outline of a document in order to aid you making sense of it's 
structure. Typically outlining is used in longer documents.

WordExpress cleverly links outlining to the related task of creating a table of contents at the end of a 
project. Here is how outlining can help develop longer documents and automate your table of contents 
generation.

1. Start a new document and click on View | Outline. This starts WordExpress in outline view 

2. Type in text as you normally might. Remember that outline view is not designed to help you type in 
the text as it will eventually look in your document but as an overview. For this reason each line 
should basically be a "heading" of a topic.

After a while you should have a series of topics listed in no particular priority other than how you 
might deal with them in sequence in a document.    At this stage all the topics are of equal priority and 
are at equal levels.

3. Go back to the first line.    Highlight it with a mouse. Use the left arrow on the control strip to "promote" 
that heading.    The right arrow "demotes" a heading.    Each of your original notes was written as 
"body text" which is the lowest level of outline. You can now promote each line and demote each line 
to one of 9 outline levels.

Experiment a little with the promoting and demoting technique. In effect you are creating section and 
sub-section headings and providing a structure or outline to a document. 

4. Much later on, when you have completed your document, the 9 outline levels will be used to build a 
table of contents when you click on Utilities | Generate TOC.

The only way you can really understand how outlining can help is by a developing a longer document 
such as a multi-page report. However the instructions above should help with the basic concepts and 
getting started.



Master Pages
Master Pages are special kinds of pages in WordExpress.    They are designed so your documents can a 
consistent feel even though they are many pages in length. 

The Master Page is selected through View | Master Page. At this point you are editing the Master Page. 

The main use for a Master Page is to insert a common numbering system in footnotes to make sure that a 
document is consistent. Although you could place a company logo in the header area on a Master Page 
to ensure it is printed on every page.

 



Troubleshooting
This series of topics deals with "troubleshooting" or what happens when things don't go quite    the way 
you expected.    Troubleshooting is not an exact science and relies on you identifying that one of the 
topics (below) that is appropriate to the problem you are having. 

This list is not exhaustive and more serious problems are best addressed by calling technical support.

Disappearing Text 
Envelope Printing 
General Protection Faults 
Missing Text (See Non-Printing Area or Printer Memory    )
Generic Printers 
KXP6100 
Non-Printing Area 
Printer Memory 
Printer Problems 
System Resources (16-Bit version)
(Low System Resources in Windows 3.1)



General Protection Faults

The General Protection Fault (GPF) is perhaps the most common fault encountered in Windows. 
However the error messages associated with this fault are so generalized they are almost useless to most 
people who use Windows every day. (The messages are useful to programmers).

Just because a program produces a GPF it does not mean that the program caused the GPF. A GPF is 
Windows way of telling us that a block of memory that one program wanted to use is already in use by 
another program. Hence the memory is "protected" and the fault is "general".

If WordExpress causes a GPF then follow these steps.

 Just because WordExpress has triggered the problem does not mean it caused the problem. That 
difference is important because around 90% of all GPFs in Windows 3.1 and 3.11 are caused by faulty 
video drivers. (See Driver    for more information about drivers).

The first step to resolving a GPF is to change your video driver. In Windows 3.1 this is done via the 
Windows Setup program in the Main program group. If you are using your manufacturers video driver 
then change it for the original driver supplied by Microsoft. This driver is normally called VGA or Super 
VGA. 

Having changed your driver if the problem magically disappears then you did have a faulty video driver 
and you should either continue using the Microsoft driver or contact your video card supplier. (See Video 
Card for more information about your display).



Printer Problems
Most support staff will tell you that printing problems occupy a large a chunk of the support call they 
receive. Therefore a short portion of this help file devoted to printing will only give a cursory coverage    
Nevertheless this section of the help file should provide some clues.

The basics of Windows printing are that Windows itself does not need to know anything about a specific 
driver because a manufacturer of a printer writes a driver for each printer produced. Windows comes with 
some printer drivers itself but these drivers are "generic" and often only support the basic functions of a 
class of printers.

All WordExpress "knows" about your printer is determined by reading the printer driver. 

If you have more than one printer on your system then you can switch between printers at print time 
through the Printer Setup dialog.

If WordExpress produces a General Protection Fault (GPF) while printing then please go through the 
troubleshooting guide on General Protection Faults. It is unlikely that the printer driver itself is faulty and is 
more likely that a rogue bitmap or some other graphics related problem has caused the fault. 

Occasionally a GPF can be produced by a printer driver. This is when a printer driver tries to print to a 
printer that is switched off or another hardware fault has been detected.

In all cases where you can't print the first task is to isolate the problem. If a hardware fault is involved then 
no Windows application will be able to print. You can test printing fairly quickly by running the Windows 
NOTEPAD (or WordPad in Windows 95) and printing something. If printing happens then you probably 
don't have a hardware problem.

The next step is to isolate the driver. Windows comes with a simple "text printer" which is sometimes 
referred to by support staff as a generic printer driver. This driver is designed to operate with the simplest 
printers that have no fonts and can't even do bold printing. As a result of this it is good for testing. 

If you haven't already installed the text printer driver do so now. Just install it as an extra printer. You don't 
need to delete your existing driver. 

If you can print from WordExpress with the text only driver then there are several possibilities. The driver 
itself may need updating. You will need to call your printer supplier. You may have some corruption on 
your hard disk which has damaged the driver. You may have corrupt fonts - the text printer driver does not 
use the wide range of fonts used by most printer drivers. In this case you will need to re-install your fonts.

Associated Topics: General Protection Faults 
Envelope Printing 
Non-Printing Area 
Printer Memory 

 



Envelope Printing
Envelope Printing has caused a lot of problems over the years. The basic problem is that WordExpress 
does not directly control your printer. Your printer is controlled by the printer driver supplied by your printer 
manufacturer.

Before you think you have a printer problem check to see that you have setup the envelope printing 
facility properly. In particular please check to see you have told WordExpress what type of envelope 
stationery you are using. Customers outside the USA should make a particular check to see they are 
using the correct ISO envelope sizes.

The most common problem is that the printer is not printing the address in the correct location. 

Mostly this problem is due to printer drivers not knowing where the envelope is fed from. Typically this 
problem is common to early Hewlett Packard drivers. You should inquire if your driver has been updated 
before spending a lot of time on this kind of problem. However assuming you have the latest driver there 
are several things you can do.

The most obvious work around is to change your envelope stationery. Using windowed envelopes will 
save time and perhaps prove easier than messing around with printer configurations. With WordExpress 
it's pretty straightforward to change to a windowed envelope. Just create a template for your regular 
stationery that puts your cursor on the correct place to start the address then type. Later on you should be 
able to fold your address perfectly to match the window.

Another solution is to develop a template to resolve the problem of the envelope address being printed in 
the wrong place. If your printer feeder supports it you might consider developing a specific "envelope 
shaped" template. Then treat addressing the same way as creating a short document. Quickly cut and 
paste the address between windows and print.

Ultimately the problem is best solved by having a good printer driver for your printer but we hope these 
hints help customers who are stuck with a printer driver that is miss-behaving.

Associated Topics: Non-Printing Area 
Printer Problems 



Non-Printing Area
Every printer has a non-printing area. This is a margin around the edge of your paper where the printer is 
not physically able to print. All printers have this area.

If you create a document that intrudes into this area portions of your document may "disappear". This is 
particularly the case if you drag a footer object into the non-printing area. To cure this problem you need 
to make sure that you have sufficient top, bottom, left and right margins in your document. The default 
values of the normal template are 1 inch (2.54 cm) margins.

If your printer manual does not tell you the extent of the non-printing area then it is fairly straightforward to 
get WordExpress to show you.

Create a document with no margins whatsoever - in other words margins set to zero.    Then create a text 
box to cover the whole page. Make sure the text box has no text in it but uses a shaded background 
color. Print the page. The non-printing area of the page should be visible as a white border around the 
box that you can measure.



Disappearing Text
Touch typists can often accidentally delete text by holding down the control key rather than the shift key. 
One of the most dangerous combinations is Control+A which selects all the text. If this is followed, for 
example, by the DELETE key then the typist could be left looking at a blank screen.

The moral of this story is that touch typists should get familiar with the PC's keyboard and the fact that 
most applications have shortcuts based on the ALT and CTRL keys.

Associated Topic: Non-Printing Area 



Printer Memory
Almost all Windows printing relies on building pages in memory. Printers with memory are able to build 
the page in their own memory whereas printers without memory rely on Windows feeding them complete 
pages.

If your printer only has a small amount of memory you may find that only a portion of a complex document 
is printed. For example only half a page may get printed. In this case you may find it better to alter your 
printer driver and tell it your printer has no memory at all so the hard work is done by Windows.

Of course if your printer has 4 megabytes of memory but the printer driver claims it only has 1 megabyte 
then Windows may be working unnecessarily hard with your printing jobs. In this case you should check 
to see that the control panel settings for your printer are accurate. 

If your printer can emulate a Hewlett Packard Printer as well as Postscript you should be aware that 
postscript requires a lot more memory. Thus it is often better to use the HP mode and get a faster 
response to printing.

Printer memory problems often look like general printing problems because you get missing text or only a 
portion of the page printed.    If your page has lots of fonts on it and several bitmaps then your printer's 
memory may be insufficient. 

Some printer memory problems can be solved by splitting documents up. For example if a 12 page 
document seems to be causing the printer to "hang" then try printing the first 6 pages then the next 6 as 
two separate jobs.

Associated Topics: Printer Problems 
Non-Printing Area 



System Resources
This topic is one of the most general. This will be most significant to customers using the 16-bit version of 
WordExpress.

If you click on HELP | ABOUT in the Program Manager of Windows 3.1 the system reports it's system 
resources. Before you start a major product like WordExpress you should have a reasonable amount of 
Windows resources available. A value of around 70% or more is typical. 

On the other hand if you have a huge number of fonts installed and are running applications concurrently 
with WordExpress this value may be lower than 50%. With such low resources you may get lots of 
unexplained application errors. 

If this sounds like your system then consider increasing the amount of memory available, decreasing the 
number of fonts you have installed and reducing the number of applications you run concurrently. All of 
these actions will help WordExpress perform better.



KXP 6100
We have had reports of printer problems with the KXP 6100 printer from Panasonic. Simply put 
WordExpress does not work correctly with this printer. 

One solution to problems relating to printers is to use a generic driver. However the Panasonic KXP 6100 
is a GDI Printer that can only use it's own drivers. 

At this time this printer is the only one we know of that will not work with WordExpress.

Associated Topic: Generic Printers 



Generic Printers
Sometimes you buy a second hand printer or you "inherit" a printer from an office that no longer wants it. 
In these cases it's unlikely it comes bundled with it's correct hardware drivers.

Fortunately Windows comes with printer drivers that are "generic" to certain classes of printer. This 
means that you can get printing almost straight-away while you try to get the real driver from the 
manufacturer. 

The "text printer" driver will work on virtually all printers except postscript. Postscript being a special case. 
You should always have a text printer driver around for testing purposes if you switch printers with 
reasonable frequency.

Most dot matrix type printers will be happy with either an Epson FX driver or an IBM Proprinter driver. 
These are the simplest dot matrix drivers around. 

The HP Laserjet driver will work with virtually all HP compatibles. The HP Deskjet driver will work with all 
Deskjet models. 

Apple Laserwriter drivers work with most postscript printers.

So if you are stuck for a driver just match one of the drivers mentioned above and you should be able to 
find something that will get your printer working.

 



Blend Dialog
A “Blend” is a visual effect where one color is blended into another.    The blend dialog allows gives you 
precise control over the blend. 

Foreground: Enter the starting color for the blend.    You may start with any shade level of any color.

Background: Specify the ending color for the blend.    You may end with any shade level of any color.

Blend: This dropdown lets you select the type of blend.    If “Blend Across” is chosen, then the 
“Foreground” color will blend to the “Background” color from left to right.    If “Blend Down” is chosen, then 
the “Foreground” color will blend to the “Background” color from the top to the bottom.    If “Radiant” is 
chosen, then the “Foreground” color will blend to the “Background” color from the outside of the object to 
the center.    If “Double Blend Across” is chosen, then the “Foreground” color will blend to the 
“Background” color from the left and right edge to the center.
If “Double Blend Down” is chosen, then the “Foreground” color will blend to the “Background” color from 
the top and bottom to the center.



Ellipse Dialog
If the selected object is an ellipse, the "Ellipse" dialog box appears when you choose the "Properties..." 
command or when you double click on the ellipse.

Size / Position Tab

Position: Enter the ellipse's size and position on the page.    It's position is measured from the top-left 
corner of the page.    It would probably be easier to change the ellipse's size and position using the mouse 
(see "Resizing an object with the mouse"), but you can also do it from this dialog if you need to specify an 
exact size and position.

Wrap Margin: Enter values for the ellipse's wrap margin.    The wrap margins determine the distance of 
the text from each side of the ellipse, or in other words, how close text in your document may appear 
above, below, or to either side of the ellipse before wrapping.    See "Changing wrap margins with the 
mouse" for more detailed information.    The wrap region is a rectangle.

By default, the position and wrap margin are specified in the default units specified in the Window’s 
control panel, but you may specify them in inches, centimeters, or points by following the number with the 
letters "in", “cm”, or "pt" (e.g. 1.00in, 2.54cm, or 72.0pt).

Properties Tab

Line Style: Select a pre-set line style from the Line Style options, or click the "Lines..." button to display 
the "Lines" dialog box for more options.

Wrap: Choose the type of wrap from this pull-down menu.    Choose "None" for no text wrapping, that is, 
text will flow over the ellipse, ignoring its wrap margins; choose "Line" if you want text to jump over the 
ellipse and continue below it; choose "Text" if you want text to wrap around all sides of an ellipse.

Shades...: Click this button to open the "Shades" dialog box where you can select a shade or fill-pattern 
for the ellipse.    This is the same as choosing the "Shades..." command from the format menu.

Circle: Click this option to change the selected ellipse to a circle.    Note that you can create circles with 
the mouse by holding the Shift key while you resize the circle with the mouse.

Color: Choose the color for the ellipse from the list of defined colors.    To define a new color or change an 
existing color, choose the “Define Colors” entry at the end of the list.



Lines Dialog
The lines dialog allows you to specify the attributes of the lines you have placed on an object. 

The following options are available:

Thickness: The thickness of the line can be decided. Usually this is expressed in "points". There are 72 
points to 1.0 inches (2.54cm).    The thickness chart gives you an idea of the typical thicknesses of some 
pre-arranged point sizes. 

You can enter any value in the thickness box. If you specify 1.0in then Word Express will create lines of 
1.0 inch in thickness. Specifying 0.1cm will create 1 millimeter lines.    These examples and chart should 
help you get the line thickness correct for your document.

Type: The type box allows you to select the type of line you require. The principle choices are between 
single and double lines but there are variations.

Color: Chose the color for the line.    You may choose one of the defined colors or you can define a new 
color (or change an existing one) by choosing the Define Colors entry at the end of the list.

Note: The sample box will change to reflect your changes. 



Paragraph Border Dialog
Paragraphs can be made more attractive by using borders. This dialog allows you to select a variety of 
border options:

Sample: This field serves two purposes.    First it displays an example of the currently selected border.    
Second it is used to specify which edges will be affected when a line style is applied.    The small cursor 
symbols ' ' are used to mark the edges that will be affected.    You can select a edge by clicking on it 
with the mouse.    Multiple edges can be selected by holding the Shift key down while you click.    The 
outer edges (i.e. the top, bottom, left, and right) may be selected by clicking on the interior of the 
paragraph.

Edit Edge: As an alternative to selecting the edges with the mouse as described above, you can choose 
the edge(s) from this menu.    "Outline" selects the top, bottom, left, and right edges.    The "Middle" edge 
is used to set the line type for lines between selected paragraphs.

Style: You may choose the line style from this menu.    The available styles are no line, a single line, or a 
double line.

Apply Style: Click on one of these predefined styles to apply that line style to the currently selected 
edges.

Lines: Click on this button to bring up the "Lines" dialog box which will allow you to apply a custom line 
style to the currently selected edges.

Clearance: Specify the distance you desire between each edge and the paragraph.    By default this 
distance is in points, but you may specify inches or centimeters by following the number with the letters 
"in" or "cm" (e.g. 1.00in or 2.54cm)

Bounds: Choose how you want the border to bound the text.    Choose "Margins" if you want the border 
to extend to the page margins.    Choose "Indents" if you want the border to extend only to the paragraph 
indents.    Choose "Text" if you want the border to extend only to the text within.

Color: Choose the color for the border.    You may choose one of the defined colors or you can define a 
new color (or change an existing one) by choosing the Define Colors entry at the end of the list.



Text / Picture Frame Border Dialog
This dialog allows you to alter the properties of the border which surrounds text or picture frames. The 
following options are available:

Sample: This field serves two purposes.    First it displays an example of the currently selected border.    
Second it is used to specify which edges will be affected when a line style is applied.    The small cursor 
symbols ' ' are used to mark the edges that will be affected.    You can select a edge by clicking on it 
with the mouse.    Multiple edges can be selected by holding the Shift key down while you click.    The 
outer edges (i.e. the top, bottom, left, and right) may be selected by clicking on the interior.

Edit Edge: As an alternative to selecting the edges with the mouse as described above, you can choose 
the edge(s) from this menu.    "Outline" selects the top, bottom, left, and right edges.

Style: You may choose the line style from this menu.    The available styles are no line, a single line, or a 
double line.

Apply Style: Click on one of these predefined styles to apply that line style to the currently selected 
edges.

Lines: Click on this button to bring up the "Lines" dialog box which will allow you to apply a custom line 
style to the currently selected edges.

Color: Choose the color for the border.    You may choose one of the defined colors or you can define a 
new color (or change an existing one) by choosing the Define Colors entry at the end of the list.



Corner Dialog
Rounded Corners: Check this box if you wish your rectangle to have rounded corners.    This will set 
defaults for the Width and Height fields.

Width: Specify the width of the ellipse which is to be used to draw the rounded corner.

Height: Specify the height of the ellipse which is to be used to draw the rounded corner.

Generally, the larger you make the Width and Height fields, the more rounded the rectangle will become.

Note: The sample box previews the effect.



Create Directory Dialog

The Create Directory dialog is only available in the 16-bit version of Word Express. It allows you to create 
a directory (folder) without leaving Word Express and having to use the File Manager.

See Directory    for more information.



Crop Picture

Cropping simply means cutting out a portion of a picture to make it fit. On this dialog you see two columns 
listed as follows:

Margin: Allows you to specify a margin size around the picture. 

Crop: Allows you to specify a reduction in the picture size by a specific percentage. For example if you 
want to cut some space off the left hand side try cropping 20% off it and so on for the other parameters.



Date / Time Format
The "Date/Time Format" dialog box allows you to enter an arbitrary date or time format.    You should 
enter a string which consists of codes from the following table which are used to build up the date and/or 
time:

Date m Month (numeric) 1
mm Month (numeric 2 digits)01
mmm Month (abbr.) Jan
mmmm Month (full) January
d Day 2
dd Day (2 digits) 02
ddd Day of week (abbr.) Wed
dddd Day of week (full) Wednesday
yy Year (2 digits) 94
yyyy Year (4 digits) 1994

Time H Hour (12 hour) 1
HH Hour (12 hour, 2 digits) 01
h Hour (24 hour) 13
hh Hour (24 hour, 2 digits) 13
M Minutes5
MM Minutes (2 digits) 05
S Seconds 9
SS Seconds (2 digits) 09
AM AM/PM PM



Group
The group dialog box allows you to edit the position, and wrap margin of a selected group. 

Position: Enter the group’s position on the page.    It's position is measured from the top-left corner of the 
page.    It would probably be easier to change the group’s position using the mouse (see "Moving an 
object with the mouse"), but you can also do it from this dialog if you need to specify an exact position.

The width and height fields are determined by the sizes of the group objects and are for informational 
purposes only.

Wrap Margin: Enter values for the group's wrap margin.    The wrap margins determine the distance of 
the text from each side of the ellipse, or in other words, how close text in your document may appear 
above, below, or to either side of the ellipse before wrapping.    See "Changing wrap margins with the 
mouse" for more detailed information.    The wrap region is a rectangle.

By default, the position and wrap margin are specified in the default units specified in the Window’s 
control panel, but you may specify them in inches, centimeters, or points by following the number with the 
letters "in", “cm”, or "pt" (e.g. 1.00in, 2.54cm, or 72.0pt).



OLE Properties
This dialog allows you to edit the properties of an OLE object. 

Size / Position Tab

Position: Enter the object’s position on the page.    It's position is measured from the top-left corner of the 
page.

Size: You may specify the width of the object as either an absolute value or as a percent of it’s original 
size.

It would probably be easier to change the object's size and position using the mouse (see "Resizing an 
object with the mouse"), but you can also do it from this dialog if you need to specify an exact size and 
position.

Wrap Margin: Enter values for the object's wrap margin.    The wrap margins determine the distance of 
the text from each side of the object, or in other words, how close text in your document may appear 
above, below, or to either side of the object before wrapping.    See "Changing wrap margins with the 
mouse" for more detailed information.    The wrap region is a rectangle.

By default, the position and wrap margin are specified in the default units specified in the Window’s 
control panel, but you may specify them in inches, centimeters, or points by following the number with the 
letters "in", “cm”, or "pt" (e.g. 1.00in, 2.54cm, or 72.0pt).

Maintain Scale Factor: Check this box if you want to maintain the specified scale factor whenever the 
object changes.    Some objects (e.g. Microsoft Word) require a 100% scale factor to display correctly.

Maintain Aspect Ratio: Check this box if you want to maintain the original aspect ration of the object.

Properties

Margins: Enter the margins between the edge of the object and the outer edge of the frame.    You can 
change the margins with the mouse by holding down the Shift key while you follow the same procedure 
for resizing the text frame.    Instead of being resized, the object margins will be set.

Wrap: Choose the type of wrap from this pull-down menu.    Choose "None" for no text wrapping, that is, 
text will flow over the text frame, ignoring its wrap margins; choose "Line" if you want text to jump over the 
text frame and continue below it; choose "Text" if you want text to wrap around all sides of the text frame.

Border: Click this button to bring up the Frame Border dialog box which allows you to specify the type of 
border which should surround the object.

Shade: Click this button to bring up the Shade dialog box which allows you to specify the background 
shade to be used for the object.    Note that many objects (such as bitmaps) are opaque and you will only 
be able to see the shade in the margin area around the object (if any).



Picture
You can edit many of the properties of your picture with this dialog.    There are three major areas that can 
be modified: size/position, properties, margin/crop.

Size/Position Tab

Position: Enter the picture’s position on the page.    It's position is measured from the top-left corner of 
the page.

Size: You may specify the width of the picture as either an absolute value or as a percent of it’s original 
size.

It would probably be easier to change the picture's size and position using the mouse (see "Resizing an 
object with the mouse"), but you can also do it from this dialog if you need to specify an exact size and 
position.

Wrap Margin: Enter values for the picture's wrap margin.    The wrap margins determine the distance of 
the text from each side of the picture, or in other words, how close text in your document may appear 
above, below, or to either side of the picture before wrapping.    See "Changing wrap margins with the 
mouse" for more detailed information.    The wrap region is a rectangle.

By default, the position and wrap margin are specified in the default units specified in the Window’s 
control panel, but you may specify them in inches, centimeters, or points by following the number with the 
letters "in", “cm”, or "pt" (e.g. 1.00in, 2.54cm, or 72.0pt).

Maintain Aspect Ratio: Check this box if you want to maintain the original aspect ration of the picture.

Properties Tab

Save w/Document: Click this option if you wish for the picture to be saved with the document.    Once the 
picture has been saved with the document, the link to the original file is lost and this option will be 
automatically checked and dimmed.

Save as Compressed: Click this option if you wish for the picture to be saved in a compressed format 
when it is saved with the document. Choosing this option can result is a significantly smaller file.

Foreground Color: Choose the foreground color you wish for the picture.    If you choose "Full Color" 
then the picture will be displayed and using the its original colors.

Background Color: Choose the background color you wish for the picture.    If you have chosen "Full 
Color" for the foreground color, then this value is ignored.

Wrap: Choose the type of wrap from this pull-down menu.    Choose "None" for no text wrapping, that is, 
text will flow over the picture, ignoring its wrap margins; choose "Line" if you want text to jump over the 
picture and continue below it; choose "Text" if you want text to wrap around all sides of the picture.

Note that the Wrap option is only available for pictures which were added using the picture tool under the 
"Tools" command on the Object menu (or from the control strip).    The Wrap option is not available for 
pictures which are inserted into the text via the "Picture" command on the Insert menu. 

Rotation: Specifies the degree of rotation for the picture in degrees clockwise.    Window’s Metafile 
pictures may be rotated to any angle.    All others may only be rotated by 0, 90, 180, and 280 degrees.

Border: Click this button to open the "Frame Border" dialog box where you can select the style of border 
to be used for the picture.



File: Click on the button to bring up the "Picture File Name" dialog box which allows you specify a new file 
name for the imported picture.    You can use this option to change the picture.

Margin/Crop Tab

Margins: Enter the margins between the edge of the picture and the outer edge of the frame.    You can 
change the margins with the mouse by holding down the Shift key while you follow the same procedure 
for resizing the text frame.    Instead of being resized, the object margins will be set.

Crop: These fields allow you to crop the picture. You enter the left, top, right, and bottom crop values as a 
percentage of the original pictures width and height.    You can change the crop the picture with the mouse 
by holding down the Control key while you follow the same procedure for resizing the picture.    Instead of 
being resized, the picture will be cropped.



Table 
The table dialog allows you to edit the properties of a table. It is divided into two tabbed dialogs that you 
can alter.

Properties Tab

Position: Enter the table's size and position on the page.    It's position is measured from the top-left 
corner of the page.    You cannot change the height of the table since the height is determined by the 
table's contents.    It would probably be easier to change the table's size and position using the mouse 
(see "Resizing an object with the mouse"), but you can also do it from this dialog if you need to specify an 
exact size and position.

By default, the position and wrap margin are specified in the default units specified in the Window’s 
control panel, but you may specify them in inches, centimeters, or points by following the number with the 
letters "in", “cm”, or "pt" (e.g. 1.00in, 2.54cm, or 72.0pt).

Grid: Click this button to bring up the "Lines" dialog box which allows you to specify the line style to be 
used to draw the internal grid lines of the table.

Border: Click this button to open the "Frame Border" dialog box where you can select the style of border 
to be used for the text frame.

Shades...: Click this button to open the "Shades" dialog box where you can select a shade or fill-pattern 
for the background of the table.    This is the same as choosing the "Shades..." command from the format 
menu.

Tabbing Adds Rows: Check this box if you want the tab key to add in rows. This happens when in the 
last cell of the table. Tab causes a new row to be added.

Wrap Tab

Wrap: Choose the type of wrap from this pull-down menu.    Choose "None" for no text wrapping, that is, 
text will flow over the table, ignoring its wrap margins; choose "Line" if you want text to jump over the 
table and continue below it; choose "Text" if you want text to wrap around all sides of the table.

Wrap Margin: Enter values for the table's wrap margin.    The wrap margins determine the distance of text 
from each side of the table, or in other words, how close text in your document may appear above, below, 
or to either side of the table before wrapping.    See "Changing wrap margins with the mouse" for more 
detailed information.    Note that if the table has been inserted into the text, the wrap margin is not used 
and is dimmed.



Edit Line
The Edit Line dialog allows you to change the properties of the line object.

From/To Positioning: The horizontal and vertical positions of the line represent the co-ordinates of the 
line on the page. You can change the horizontal and vertical positions manually by entering in values. 
However the easiest way to move the line is to pick it up with the mouse and move it as a complete 
object. You can move, stretch or change position using the normal windows mouse methods. 

Thickness: The thickness of the line can be easily adjusted by entering in a value. Normally this is 
expressed as points. There are 72 points to 1 inch (2.54 cm).    There are some pre-defined thicknesses in 
the central portion of the dialog. If you want to use one of those just click the mouse on them.

Color: Choose the color for the line.    You may choose one of the defined colors or you can define a new 
color (or change an existing one) by choosing the Define Colors entry at the end of the list.



Edit Rectangle

Size/Position Tab

Position: Enter the rectangle's size and position on the page.    It's position is measured from the top-left 
corner of the page.    You cannot change the height of the table since the height is determined by the 
table's contents.    It would probably be easier to change the table's size and position using the mouse 
(see "Resizing an object with the mouse"), but you can also do it from this dialog if you need to specify an 
exact size and position.

Wrap Margin: Enter values for the rectangle's wrap margin.    The wrap margins determine the distance 
of text from each side of the table, or in other words, how close text in your document may appear above, 
below, or to either side of the table before wrapping.    See "Changing wrap margins with the mouse" for 
more detailed information.    Note that if the table has been inserted into the text, the wrap margin is not 
used and is dimmed.

Properties Tab

Line Style: Select a pre-set line style from the Line Style options, or click the Lines button to display the 
"Lines" dialog box for more options.

Wrap: Choose the type of wrap from this pull-down menu.    Choose "None" for no text wrapping, that is, 
text will flow over the object, ignoring its wrap margins; choose "Line" if you want text to jump over the 
object and continue below it; choose "Text" if you want text to wrap around all sides of an rectangle.

Square: Click this option if you want the selected rectangle to be a square, that is, setting the rectangle's 
height equal to its width.    Note that you can create squares by holding down the Shift key while your are 
resizing the rectangle with the mouse.

Rounded Corners: Click this option if you want the rectangle to be round-corner rectangle, all four 
corners will be rounded.    You can control the degree of rounding by pressing the Corners button to 
display the “Corner” dialog box.

Shades: Click this button to open the "Shades" dialog box where you can select a shade or fill-pattern for 
the rectangle.    This is the same as choosing the "Shades..." command from the format menu.

Note: The sample box illustrates the changes that you make as a preview before you click on OK to 
finalize the changes.



Text Frame
The text frame dialog is    a tabbed dialog like many of the other dialogs in Word Express. It contains the 
following elements;

Set Default: Click this button if you want the settings you have specified to be used as default whenever 
a new text frame is created.

Position Tab

Position: Enter the text frame's size and position on the page.    It's position is measured from the top-left 
corner of the page.    It would probably be easier to change the frame's size and position using the mouse 
(see "Resizing an object with the mouse"), but you can also do it from this dialog if you need to specify an 
exact size and position.

Wrap Margin: Enter values for the text frame's wrap margin.    The wrap margins determine the distance 
of text external to the frame from each side of the frame, or in other words, how close text in your 
document may appear above, below, or to either side of the frame before wrapping.    See "Changing 
wrap margins with the mouse" for more detailed information.

By default, the position and wrap margin are specified in the default units specified in the Window’s 
control panel, but you may specify them in inches, centimeters, or points by following the number with the 
letters "in", “cm”, or "pt" (e.g. 1.00in, 2.54cm, or 72.0pt).

Properties Tab

Rotation: Text frames may be rotated by 0, 90, 180 and 270 degrees measured clockwise from the 
vertical.

Alignment: Specifies the vertical alignment of the text within the frame and may be either “Top”, to align 
the top of the text with the top of the frame; “Center” to center the text within the frame, “Bottom” to align 
the bottom of the text with the bottom of the frame, or “Flush” to adjust the line spacing so that the text 
exactly fits the frame.

Wrap: Choose the type of wrap from this pull-down menu.    Choose "None" for no text wrapping, that is, 
text will flow over the text frame, ignoring its wrap margins; choose "Line" if you want text to jump over the 
text frame and continue below it; choose "Text" if you want text to wrap around all sides of the text frame.

Wrap Text: Click this option if you want text contained within the text frame itself to wrap around any 
objects placed within the frame.

Border: Click this button to open the "Frame Border" dialog box where you can select the style of border 
to be used for the text frame.

Shades: Click this button to open the "Shades" dialog box where you can select a shade or fill-pattern for 
the background of the text frame.    This is the same as choosing the "Shades..." command from the 
format menu.

Margins Tab

Margins: Enter the margins between the edge of the text frame and the text.    You can change the 
margins with the mouse by holding down the Shift key while you follow the same procedure for resizing 
the text frame.    Instead of being resized, the text margins will be set.

Growth Tab

The size of a text frame can be either fixed, or the frame can grow and shrink to fit the text within.    This 



tab allows you to specify how the text frame is to grow (if at all).

Horizontal: Specifies how the frame is to grow horizontally.    You may choose it to be “Fixed” in which 
case the horizontal size is fixed (that is you must change it manually).    If you choose “Align Left”, “Align 
Center”, or “Align Right”, then the width of the frame will be set to the width of the text it contains.    When 
new text is added or text is deleted, the text frame will grow or shrink.    When this happens, if you chose 
“Align Left” then the left edge of the frame will remain fixed and the right edge will be adjusted.    If you 
chose “Align Center”, then the horizontal center of the frame will remain fixed and the left and right edges 
will be adjusted.    If you chose “Align Right”, then the right edge of the frame will be fixed and the left 
edge will be adjusted.

Vertical: Specifies how the frame is to grow vertically.    You may choose it to be “Fixed in which case the 
vertical size will be fixed (that is you must change it manually).    If you choose “Align Top”, “Align Center”, 
or “Align Bottom”, then the height of the frame will be set to the height of the text it contains.    When new 
text is added or deleted, the text frame will grow or shrink.    When this happens, if you chose “Align Top” 
then the top edge of the frame will remain fixed and the bottom edge will be adjusted.    If you chose “Align 
Center”, then the vertical center of the frame will remain fixed and the top and bottom edges will be 
adjusted.    If you chose “Align Bottom”, then the bottom edge of the frame will be fixed and the top edge 
will be adjusted.

Maximum: Specifies the maximum width or height that the text frame can become.

Minimum: Specifies the minimum width or height that the text frame can become.



Text Effect
Text effects allow you to manipulate text to provide a wide variety of effects.

Effect: Specifies the type of effect you wish to have. You can make text scroll into the distance or 
"balloon" towards you - to choose two examples. As you pick the type of effect you want the sample 
window shows how it might appear.

Variation: Specifies the effect variation.    The choices available here depend on the selected effect.    
Possible choices are “Normal”,    “Perspective” which is used with effects like “Perspective Left”, and 
“Stretched” which is used with effects like “Circle, Thin”.    Feel free to experiment with the variations to get 
a feel for how they change the effect.

Font: This controls which font that your text effect will appear like. Only True Type fonts may be used

Style: Specifies the style of font to use.    Only the “true” styles available for a font appear.    A “true” style 
is one for which a True Type outline exists, and is not produced algorithmically by Windows. 

Alignment: For some effects, this determines whether the text is left aligned, centered or right aligned.

Fill: Brings up a Shades dialog box which lets you specify the fill pattern (if any) for the inside of your 
characters.

Shades: Brings up a Shades dialog box which lets you specify the fill pattern (if any) which is to be used 
behind the text.

Outline: Brings up a Lines dialog box which lets you specify the line type (if any) to be used to outline 
your characters.

Border: Brings up a Lines dialog box which lets you specify the line type (if any) to be used to border the 
effect.

Shadow: Brings up a Shades dialog box which lets you specify the fill pattern to be used for the drop 
shadow characters (if any) which are placed behind your characters.

More: Brings up the Text Effect Frame Dialog Box which lets you specify the additional attributes about 
the frame which surrounds the text effect.



Text Effect Frame
This dialog controls the variety of changes that you can make to the frame that surrounds the text effect.

Position: Enter the effect's size and position on the page.    It's position is measured from the top-left 
corner of the page. It would probably be easier to change the effect’s size and position using the mouse 
(see "Resizing an object with the mouse"), but you can also do it from this dialog if you need to specify an 
exact size and position.

Wrap Margin: Enter values for effect's wrap margin.    The wrap margins determine the distance of text 
external to the frame from each side of the frame, or in other words, how close text in your document may 
appear above, below, or to either side of the frame before wrapping.    See "Changing wrap margins with 
the mouse" for more detailed information.

Frame Margin: Enter the margins between the edge of the effect and the outer edge of the frame.

Text Margin: Enter the margin between the text within the effect and the outer edge of the envelope 
which contains the text.    The effect of this control is fairly subtle.    To best see the effect, choose 
“Perspective right” and set a border using the Border button on the main text effect page.    You should 
see an effect which looks something like:

Notice how the text touches the border?    Now set the all of the fields in the text margin section to 5.0 %. 
The text effect should now appear as follows:

Notice the space between the text and the border?    If you increase the text margin, this space will 
increase.

Wrap: Choose the type of wrap from this pull-down menu.    Choose "None" for no text wrapping, that is, 
text will flow over the text effect, ignoring its wrap margins; choose "Line" if you want text to jump over the 
text effect and continue below it; choose "Text" if you want text to wrap around all sides of the text effect.

Shadow Offset: Specifies the offset of the drop shadow characters (if any) as a percentage of the size of 
the effect

Rotation: Specifies the angle at which the effect is rotated in degrees clockwise from the vertical.



Shades: Brings up a Shades dialog box which lets you specify the background shade for the entire 
frame.

Lines: Brings up a Lines dialog box which lets you specify the line type for the border which surrounds 
the text effect frame.



 File Search

The "Search for File" dialog allows you to specify a search for any document type supported by Word 
Express. You can also specify a search for details included in your file summaries. (See Summary    for 
more information on file summaries).

The search subdirectories checkbox needs to be highlighted to search lower than your current directory. 
To search you whole hard disk then the starting directory needs to be set to the root directory. You can 
alter the drive and directories to be searched by using the standard Windows navigation menus on the 
right.

TIP: Fill in your file summary when editing a document to make it easier to find files later on.

The following buttons are available on this dialog:

New List: This allows you to start a new search list.    This removes the previously found set and replaces 
it with documents based on the new search criteria.

Add To List: Click this option if you want to add the new document search to your existing list. 

Cancel: Cancel this dialog and return to the previous one.

Warning: The file finding features of Word Express are very powerful. Be particularly careful with deleting 
files.



Format ASCII
In preparation to save a file as formatted ASCII there are some additional bits of information Word 
Express needs to know. This dialog allows you to enter that information.

Spacing: This allows you to enter typical character spacing. Formatted ASCII will not contain the fonts 
that you used in the original Word Express document so you need to tell Word Express what spacing you 
require. This is done in characters per inch. Typical values are 10 characters per inch and 6 lines to one 
vertical inch. This allows 60 lines to a US letter sized sheet of paper. (1 inch = 2.54 cm).

Unprintable Margins: Most printers have a non-printing margin around the paper. This is where the 
paper covers an area the printer physically can't print on. You can enter in this value here.

Check the DOS/PC-8 character set    box if you want to save using a standard DOS character set. 
Otherwise the character set will be ANSI/Windows. (See the glossary for more information on this 
terminology if you require it.



New Picture
This dialog appears when you need to insert a new picture into the document. 

Select the picture by navigating windows. The preview window will display an approximation of the picture 
for you.    If you check the box to always preview a file it will do this automatically in future.

Check boxes are also provided to force Word Express to save the bitmap with the document and to 
merge the picture. If the merge checkbox is activated this forces a new dialog to appear so you can 
choose which field in the current database the picture information is stored.

Note: Merging is an advanced feature. For a detailed look at merging please see the hints and tips 
section.



Picture Merge
This dialog becomes active when you tell Word Express that the inserted picture's details are stored in a 
database.

Typically a database will have the full path of a picture stored. So, for example, it might store "C:
\PICTURES\BITMAP.BMP" in the first field. By double-clicking on field one on this dialog you tell Word 
Express to look here for field information.



New Table
The New Table dialog allows you to set-up the dimensions and properties of a new table.

On the left you can type in the values for the number of rows an columns required. Note that later on you 
can edit these and add in more rows or columns as required. At this point you should approximate your 
requirements if you are unsure. You can also use a mouse to increase or decrease the numeric values by 
clicking on the up/down arrows.

On the right hand side are the values for the current margins for the table. These are expressed in the 
current measurement units. Usually inches for North America and metric for the rest of the world. 
However this will depend on the settings of your PC.



Outline 
This dialog allows you to change the outline of the text effect box.    The easiest method is to click on the 
preferred box on the screen.



Paste Cells
This dialog allows you to control how cells are pasted into a table.

Insert Rows: The cells are inserted as new rows above the current row.

Append Rows: The cells are inserted as new rows below the last row of the table

Insert Columns: The cells are inserted as new columns to the left of the current column

Append Columns: The cells are inserted as new columns to the right of the last column in the table.

Note that depending on the size number of rows and columns of the table and the number of rows and 
columns on the clipboard, some of these options may not be available.



Preview Document
Document preview allows you to see an impression of the document before you load it into Word 
Express.



Rename Style
The rename style dialog allows you to rename an existing style to a new name. 

Simply type in the new name in the dialog box and click on OK.

TIP: It is safer to create a new variation on an existing style than totally rename a style in case you need 
it later on. 



Spell Check
The spell check dialog allows you a variety of options during a spelling check. Each of the options is on a 
button.

Change: Changes the mis-spelling to the one in the Change-To box.

Change All: This makes the current change and then changes every subsequent occurrence of the same 
error.

Ignore: Ignore the mistake on this occasion.

Ignore All: Ignore all occasions when this mistake is discovered.

Stop: Stop the spell check immediately.

Add Word: Add the current word to the dictionary.

Undo Last: Undo the last command.

Note: You can type your own changes into the "Change To:" box. 



Spell Check Start
This dialog box allows you to choose whether you want to check the spelling of the entire document, from 
the caret position to the end of the document, or the current selection (or word if no text is selected), 



Picture Warning

This dialog is displayed when Word Express has detected that a picture you have previously inserted is 
not available. You should check your system to determine what has happened to the picture.

TIP: One way to avoid this kind of error is to store the picture in the document so it is always available.



Fit On Page
This dialog lets you control the "Fit on Page" feature. Word Express allows you to work around those 
annoying occasions where a document spills onto a line or two of another page. 

In order to fit the document back onto the previous page it reduces the font size of all the fonts in your 
document proportionally. In this way the annoyance of spilling a line or two of text onto another page can 
be avoided. 

TIP: Another way of doing the same thing, but rather less scientific and automatic, is to reduce the 
margins of your page so that more text can fit on the page. On longer documents this can have a 
dramatic effect on the use of paper. 



Insert Footnote Options
The options button allows the following.

Numbering: Whether to restart on each page or not.

Line Separator Margin:  The separation of the main text from the note.

Position: Should the footnote appear at the bottom of a page, at the end of a chapter or as a bibliography 
at the end of the whole document.



Rename Index Entry
The current name of the index appears in this dialog box. Below, highlighted, is the current name waiting 
to be edited. Enter the new name and click OK.

Click on the cancel button to abort this function if you change your mind.



Define Color
If you choose the “Define Colors” entry in any color combo box, you will be presented with this dialog box 
which will allow you to define new colors or change existing colors



Define Color Changes
You have made a change to a color which has not been saved.    You may continue and lose those 
changed, add the color to the color table (if it is a new color), change the color (if it is an existing color), or 
cancel and return to the “Define Color” dialog box.



Tip Of Day
If enabled, this dialog box displays a useful tip each time you start WordExpress.    If you do not wish to 
see these tips, you can un-check the “Show Tips at Startup” checkbox.    If later you decide you wish to 
see the tips again, you can enable them by choosing the “Tips of the day” menu option under the “Help” 
menu.



Tips Of The Day
The following is a complete list of the tips of the day.

· If you always want a new window created with the New and Open commands of the File menu.    You 
can specify this by choosing the "Preferences..." command from the Edit Menu and checking the 
Default New Windows option in the General folder.

· The four most recently used documents are listed at the bottom of the File menu for easy access.

· When drawing objects, press the Shift key to constrain the object.

· Even though WordExpress usually displays values in inches, you can also specify points or 
centimeters in edit boxes that accept units by appending "pt" or "cm"

· Tips of the day are fast becoming a standard.

· You can create horizontal and vertical guides with the pointer tool by clicking and dragging from the 
horizontal or vertical ruler.

· Double clicking anywhere inside the speed tools palette opens the "Customize Speed Tools" dialog 
box.

· Check the "Use first record for field names" option in the "Set Database" dialog box if you are merging 
from a CSV file, when the first record contains the field names.

· You can save a frequently used document as a template so that you can find it quickly and easily.

· You can customize the foreground and background colors WordExpress uses in the "Preferences" 
dialog box.

· You can center objects on a point by using guides, and checking the "Snap to center" check box in 
the "Set Grid" dialog box.

· You can rotate Windows Metafiles and Text Effects at any arbitrary angle.

· You can go to "Full Page view" to get a quick look at what your output will be like.

· White text on a black background will only work with LaserJet compatible printers if you turn font 
downloading off.

· If you want to, you can turn off the tips of the day by turning off the "Show Tips of the Day" check box

· You can change the units for the Rulers via the measurements set in the Control Panel.

· Documents saved as templates must be saved in the 'TEMPLATE' sub-directory for WordExpress to 
recognize them.

· Tabs can be add by choosing the tab type from the control strip and clicking on the horizontal ruler 
bar.

· When you save a WordExpress document as a text file, only document text is exported.    To save all 
text in a text file, use the formatted ASCII file type.

· To speed up printing, you should turn off the "Collate Copies" option if you are printing multiple copies 
on a laser printer.

· When the "Customize Speed Tools" dialog box is open, you can re-arrange the icons on the speed 
tool bar by clicking and dragging.

· You can have separate headers and footers for even and odd pages by checking the "Use Facing 
Pages" box in the "Chapter" dialog box.

· You can go to a chapter and page by typing the "c-p" in the "Go To" dialog box, where 'c' is the 
chapter number and 'p' is the page number.

· You can print double sided documents by using the "Even" and "Odd" check boxes in the "Print" 



dialog box.

· You can create and maintain comma-separated (CSV) data files in WordExpress.    Each line 
comprises an individual record, with records separated by commas.

· The default character and paragraph attributes (including font) are determined by the paragraph style 
"Normal."    If you change this style and save the style sheet as "normal.wt2", then new documents will 
use this style.

· You can use text effects to rotate text to any angle.

· Linked text frames are very useful for laying out newsletters.

· You can enter a soft hyphen by holding down the control key and pressing '-' (minus).

· Use the "Before" and "After" fields of the paragraph dialog box to add space before and after 
paragraphs.

· You can double spaced your text by setting the "Line Spacing" field in the paragraph dialog box to 
200%.

· Clicking the right mouse buttons brings up a menu which allows you to modify the attributes of 
whatever is underneath the cursor.

· Set the "Display Field Codes" in the document preferences dialog box to display    field codes rather 
than their values.

· In the "Customize Speed Tools" dialog box, you can drag the icon that is in the center of the dialog 
box to the speed tools bar to add that tool to the bar.

· Objects placed on the master page will be repeated on every page in the document.

· You can delete tabs by clicking on the tab in the horizontal ruler and dragging the tab off the ruler.



Insert Object
This dialog box allows you to select what type of OLE object you wish to create.    You may choose to 
create a new object or create an object from a file.    In the latter case, you may choose to link the object 
to the file.



Resizing an object with the mouse

To change an object's size, first select the object by clicking it,    then move the mouse directly over one of 
its sides or one of its corners.    Make sure to position the pointer over the object boundary itself and not 
its wrap margin (the light colored border line around the outside of the object).    The pointer changes to a 
white double arrow:  depending on which side or corner it is positioned.    Simply click and drag 
in one of the directions of the double-arrows to increase or decrease the object's size.

If the object being sized is a rectangle, or ellipse, then holding down the shift key when resizing the object 
constrains its aspect ratio to a square or a circle.

Note that if the wrap margin has been set to zero then you will not be able to size the object without first 
dragging the wrap margin out.



Moving objects with the mouse

To move an object, first switch to object mode, click the pointer anywhere on the object and drag.    The 

pointer changes to  when you position it over a selected object.    When you let go of the mouse button, 
the object is moved to the new location.    It is still selected, allowing you to move it again, format it, delete 
it, etc.    Objects can not be moved past the edges of a page.    If you want to move an object to a different 
page, you have to cut it, go to the destination page, then paste the object.



Changing wrap margins with the mouse

When you select an object, a border line appears around it.    This line represents the object's "wrap 
margin".    The wrap margin determines how close text in your document may appear above, below, or to 
either side of an object before wrapping.    To change an object's wrap margin, first click the object, then 
move the mouse directly on top of the wrap margin you want to change.    The pointer changes to a gray 
double-arrow:  depending on which wrap margin you want to change.    Simply click and drag in 
one of the directions of the double-arrows to increase or decrease the wrap margin.



Selecting An Object

You select objects in object mode by clicking them with the mouse.    When an object is selected, it is 
highlighted.    A lighter colored border line also appears around the outside of the object - this is the 
object's wrap margin.    Wrap margins determine how close text in your document will appear to the object 
before wrapping over or below the object. (See Changing wrap margins with the mouse for more 
information.)

Selecting multiple objects

You can select more than one object at a time by holding down the Shift key when you click.    For 
example, select an object with the mouse, hold down the Shift key, and click another object.    Both 
objects are now selected.    While still holding down the Shift key, click another object.    Now three objects 
are selected.    Selecting multiple objects makes changing their attributes easy because you can change 
them all at once.    You can also move multiple objects together as a group.

A second way to select with multiple objects is to click and drag in the document at a position where there 
are not any objects.    As you drag, a rectangle will be drawn.    When you release the mouse button, all 
objects which intersect with the rectangle will be selected.



Object Mode vs. Text Mode

WordExpress has two modes - text mode and object mode.    Text mode is where you enter and format 
text.    Objects are created and manipulated in object mode, also called pointer mode because you switch 
to this mode by clicking the pointer button.    The difference between the two modes is quite obvious: you 
select text with the I-beam cursor (text mode), and graphic objects wit the arrow pointer (object mode).    
Each mode has its own button on the control strip:

Click this button to switch to text mode where you can enter, edit, and format text.

Click this button to switch to object mode where you can create, modify, and position graphic 
objects, pictures, text frames, and tables.

You can also switch between text and object modes by clicking the right mouse button or by using the 
"Text Mode" and "Object Mode" commands on the View menu.

WordExpress knows which commands are available in which modes.    Most Format menu commands 
(except for "Borders...", "Lines...", and "Shades..."), for example, are not used to manipulate objects, and 
are therefore grayed out when you click the pointer button.    Likewise, most of the Object menu 
commands are unavailable when you are in text mode.    Certain types of objects - specifically text frames 
and tables - possess attributes that are edited using both modes.    The text contained within a text frame 
is edited in text mode, but the frame itself - its size, position, border, and fill attributes - are edited in object 
mode.

 



Introducing WordExpress
WordExpress is a program designed to meet almost everyone's daily word processing needs. 

This section of the on-line help covers the following topics;

Upgrading from version 1 
Differences between versions 
Using this Help File 

If you wish to examine any of the above topics right now just click on the option you require and you will 
jump to the appropriate section. However if you have never used WordExpress before you can take a 
quick tour of the elements of a WordExpress screen by clicking on the various parts of the graphic below.

TIP: If you cannot see the whole graphic below then maximize your help screen by clicking on the 
maximize icon on the top right corner of this window.

Note: The above screen illustrates the 32-bit variant of WordExpress running under Windows 95. If you 
are using the 16-bit version the appearance will be slightly different.



Main Editing Screen
The Main Editing Screen is the area of WordExpress where you will be doing most of your work. You can 
type text in this area, highlight text for cutting and pasting, and view your work in various ways from the 
View options on the menu.

TIP: Use the Page Setup option from the FILE menu to alter your page size. You can also alter paper 
sizes to include international standards such as A4.



Menu Bar
The Menu bar allows you control all the options within WordExpress. It can be activated by clicking your 
mouse on the underlined letter or from the keyboard by holding down the ALT key and then pressing the 
underlined letter. For example ALT + F will access the File menu.



Speed Tools Bar
Speed Tools are a quick way of gaining access to some of the most commonly used functions in 
WordExpress. You can customize the Speed Tools to your personal preferences, however that kind of 
function is beyond the scope of this brief introduction to the screen elements. For the moment simply 
accept the default settings.

TIP: If you leave your cursor on a Speed Tool for a couple of seconds a description of the function of that 
tool will "pop-up" to assist you. 



Control Strip
The Control Strip cannot be customized but it includes controls to use italics, underline text and add bold. 
You can also easily change typefaces and the point size of text. All of these features are covered in much 
more detail in the Reference Guide. For now we just want to make you aware of the position of this bar in 
relationship to the rest of the screen.



Status Line
The Status Line keeps track of where you are in the document you are editing. It will indicate the page 
you are on, the line, whether you are inserting text or overwriting text. In short you can keep track of your 
work by glancing at the status line.



Upgrading from version 1
If you have got as far as reading the version 2.0 help files then you will have already installed version 2.0 
and upgraded your system. However there are a few changes in version 2.0 you should be aware of in 
order to make the most out of the new version.

NOTE: This section is specifically designed for customers who have experience of version 1.0 and 1.1 of 
WordExpress. Therefore we would expect that novice computer users may not be familiar with how to 
modify their existing installations. If you are a novice or inexperienced computer user we strongly advise 
that you make a backup of any important files you have in WordExpress version 1.0 before you carry out 
any of the advice contained in this section.

Firstly you need to know about something that hasn't changed. Version 2, like version 1, uses template 
files that are located in the template directory. (See Template for more information).

You may already have several template prepared with version 1.    These templates have the file 
extension WT1. New version 2.0 templates have the file extension version WT2. We suggest that you 
start up version 2.0 of WordExpress and open the version 1.0 templates you already have created. Any 
you want to use should be modified, if required,    and re-saved in the version 2 format.    (See File 
Extension    for more information about file extensions).

You don't have to specifically tell version 2.0 to save templates in the new format as this will happen 
automatically. Remember to save your new templates in the version 2.0 template directory. 

WordExpress version 1.0 documents can be read by version 2.0. You can safely copy ALL the files with 
WD1 extensions into the directories you have chosen for version 2.0. If you re-save these documents 
they will be saved with a WD2 extension. At a later stage you can safely delete, using File Manager in 
Windows 3.1 or Explorer in Windows 95, any files that have the same name but have a WD1 extension 
rather than a WD2 extension. Such files are likely to be newly saved versions of your older files.

Of course if you have time or very few document files you can read in each of the old version documents 
and re-save them now.    You can then delete all your version 1.0 files at a stroke.

Once you are clear that all your data has been copied from your old installation then you can safely delete 
all your remaining version 1.0 files.

NOTE: WordExpress version 1.0 maintained all it's files in it's own directories and did not copy files into 
your Windows directory or your Windows system directory.    Once your WordExpress 1.0 directories are 
deleted you will have removed all associated files.

WARNING: If you delete any files on your system then obviously they are gone and cannot be recovered. 
Before you delete your documents we strongly advise you to make a backup of any important information 
first.

Please see the GLOSSARY for definitions of any terms that are used in this section that are not familiar to 
you.



Differences between versions

WordExpress version 2.0 comes in two variations to reflect the different versions of Windows that are 
currently available. 

These variations are described simply as 16-Bit WordExpress and 32-Bit WordExpress. The 16-Bit 
WordExpress is suitable for Windows 3.1 and Windows 3.11. The 32-Bit WordExpress is suitable for 
Windows 95 or Windows NT. 

In fact the 16-Bit version of WordExpress will run under Windows 95 but the 32-Bit version, because it is 
designed to work with Windows 95, should work better.

In general the same features are available in both variations.    The following features (below) are the 
ones that are only available in the 32-Bit (Windows 95) version:

Send Mail 

In MAPI enabled Windows configurations    you can send e-mail directly within WordExpress    including 
add document attachments.    You can also use this facility to fax documents from Windows 95's FAX 
facility. (See MAPI    for more information).

OLE/2 

In Windows 95, OLE/2 container support is provided.    This allows you to use objects created in other 
applications, and have them linked or imbedded within your documents.    (See OLE for more 
information.)

Other differences between the variations of WordExpress are caused by the different dialog boxes used 
by Windows 95. The screen shots in this help file, for example, were done running under Windows 95.



Using this Help File
In order to make the best of this help file an understanding of the notation used in the help file and how to 
navigate the system is an advantage.

Graphics

Graphics are used throughout this help file to illustrate the screens you might    see on your screen. Many 
of the graphics images have hotspots. By clicking on a hotspot the help system will take you to a relevant 
piece of information. An example of this is on the section Introducing WordExpress although many of you 
will already be familiar with this approach. 

Areas that contain hotspots cause the cursor to change to a hand symbol. Hotspots can be accessed by 
clicking on the area covered by the hand.

Keystrokes

Keystrokes are described by their letter in capitals. So for example if the text asked you to type the T key 
it literally means an upper case T. The sequence ALT+T would mean hold down the ALT key on the 
keyboard and while keeping it held down type "t". The sequence CTRL+T means hold down the control 
key, marked CTRL on most keyboards, and while keeping it held down type "t".

In this context the "+" sign really means using those keys in a sequence while keeping them held down. 

Menus

To describe a location of a menu we might use a hotspot graphic. However that is more difficult in a 
sentence like this. One convention to walk you through a menu sequence is to describe it like this: FILE | 
NEW | OK.

In this example we mean take the "File Menu" item, then pick the item coming from the file menu headed 
"New" and then click on OK.    This kind of description is used where a graphic with hotspots would be 
inappropriate or would move you too far away from the explanation.
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Windows 95 Fax
If you have installed Microsoft Exchange as part of Windows 95 and you have a FAX modem in your PC 
you will be able to "Send Mail" via FAX. 



Keyboard Shortcuts
WordExpress provides quick access to many of the commands and dialog boxes available through the 
menus.    Wherever possible, WordExpress conforms to standard shortcuts keys as set forth in the 
Windows Guidelines.    This helps standardize on common functions, allowing you to more easily learn 
new applications.

With Keyboard Shortcuts you can:

• Access commonly used functions and dialogs
• Easily move through the document
• Select and format text

Choose from the following:

File Shortcuts
Windows Shortcuts
Clipboard Shortcuts 
Cursor Movement Shortcuts
Text selection Shortcuts
Text editing Shortcuts
Character Formatting Shortcuts
Paragraph Formatting Shortcuts
Command Shortcuts



Keyboard Shortcut List

File Shortcuts

The following shortcuts are used when working with files:

Ctrl-D Access File Manager
Ctrl-N Create a new file
Ctrl-O Open an existing file
Ctrl-S Save the current file
Ctrl-W Close the current file
Ctrl-P Print the File
Ctrl-T Edit document summary
Ctrl-Q Exit WordExpress

Windows Shortcuts

The following shortcuts help manage the windows within WordExpress:

F1 Bring up the Windows Help facility. 
Ctrl-F4 Closes the current document window.
Alt-F4 Exits WordExpress.
Ctrl-F5 Restores the current document window to normal size.
Alt-F5 Restores the main WordExpress window to normal size.
Ctrl-F6 Cycles to the next open document window.
Sh-Ctrl-F6 Cycles to the previous open document window.
Ctrl-F9 Minimizes the current document window.
Alt-F9 Maximizes the current document window.
Ctrl-F10 Minimizes the main WordExpress window.
Alt-F10 Maximizes the main WordExpress window.

Clipboard Shortcuts

The following shortcuts move selections between documents and the clipboard.

Ctrl-X Cut the selected text or object to the clipboard.
Shift-Del Cut the selected text or object to the clipboard.
Ctrl-C Copy the selected text or object to the clipboard.
Ctrl-Ins Copy the selected text or object to the clipboard.
Ctrl-V Paste the contents of the clipboard to the document.
Sh-Ins Paste the contents of the clipboard to the document.

Cursor Movement Shortcuts

The following shortcuts are used when selecting text:

LArrow Move to the previous character
RArrow Move to the next character
Ctrl-LArrow Move to the previous word
Ctrl-RArrow Move to the next word
UArrow Move to the previous line
DArrow Move to the next line

Ctrl-9 Move to the previous sentence
Ctrl-0 Move to the next sentence
Ctrl-UArrow Move to the previous paragraph



Ctrl-DArrow Move to the next Paragraph

Home Move to the beginning of line
End Move to the end of line
Ctrl-Home Move to the beginning of document
Ctrl-End Move to the end of document

PgUp Move to the previous window
PgDn Move to the next window
Ctrl-PgUp Move to the beginning of current window
Ctrl-PgDn Move to the end of current window

Tab Move to next cell (tables only)

Text selection Shortcuts

The following shortcuts are used when selecting text:

Sh-LArrow Select the previous character
Sh-RArrow Select the next character
Sh-Ctrl-LArrow Select the previous word
Sh-Ctrl-RArrow Select the next word
Sh-UArrow Select the previous line
Sh-DArrow Select the next line

Sh-Ctrl-9 Select the previous sentence
Sh-Ctrl-0 Select the next sentence
Sh-Ctrl-UArrow Select the previous paragraph
Sh-Ctrl-DArrow Select the next Paragraph

Sh-Home Select to the beginning of line
Sh-End Select to the end of line
Sh-Ctrl-Home Select to the beginning of document
Sh-Ctrl-End Select to the end of document

Sh-PgUp Select up one window
Sh-PgDn Select down one window
Sh-Ctrl-PgUp Select to the top of current window
Sh-Ctrl-PgDn Select to the bottom of current window

Ctrl-A Select entire document or text frame

Text editing Shortcuts

The following shortcuts perform standard text editing commands:

Ctrl-Z Undo/Redo the last command or action.
Alt-BkSp Undo/Redo the last command or action.

BkSp Delete the previous character or selection.
Del Delete the next character or selection.

Sh-Enter Inserts a line break within the current paragraph.
Enter Inserts a paragraph break.
Ctrl-Sh-Enter Inserts a column break.
Ctrl-Enter Inserts a page break.



Character Formatting Shortcuts

The following shortcuts perform text formatting commands:

Ctrl-B Apply bold to the selected text 
Sh-Ctrl-B Apply bold to the selected text 
Ctrl-I Apply Italics to the selected text 
Sh-Ctrl-I Apply Italics to the selected text 
Ctrl-U Apply continuous underline to the selected text 
Sh-Ctrl-U Apply continuous underline to the selected text 
Sh-Ctrl-W Apply word underline to the selected text 

Ctrl-K Toggle Small Caps for selected text
Sh-Ctrl-K Toggle Small Caps for selected text

Ctrl-+ Superscript selected text (numeric keypad)
Ctrl-- Subscript selected text (numeric keypad)
Ctrl-* Turn off Super/Subscript (numeric keypad)

Ctrl-T Access the character dialog box
Ctrl-F Access the Font drop down on the control strip
Ctrl-P Access the Point Size drop down on the control strip

Paragraph Formatting Shortcuts

The following shortcuts perform text formatting commands:

Sh-Ctrl-L Left align the selected paragraphs
Sh-Ctrl-R Right align the selected paragraphs
Sh-Ctrl-C Center align the selected paragraphs
Sh-Ctrl-J Justify the selected paragraphs

Ctrl-1 Set line spacing to single spacing
Ctrl-2 Set line spacing to one and one half spacing
Ctrl-3 Set line spacing to double spacing

Ctrl-7 Decrease paragraph left indent
Sh-Ctrl-7 Decrease paragraph first line indent
Ctrl-8 Increase paragraph left indent
Sh-Ctrl-8 Increase paragraph first line indent

Ctrl-4 Insert today's date
Ctrl-5 Add bullets to selected paragraphs
Ctrl-6 Add auto-numbers to selected paragraphs

Ctrl-M Access the paragraph dialog box.
Sh-Ctrl-S Access the paragraph drop down on the control strip.

Command Shortcuts

The following shortcuts are used when working with files:

Ctrl-F Search for patterns in text
Ctrl-H Search and replace patterns in text
F3 Repeat last search or replace



Ctrl-E Print Envelopes
Sh-Ctrl-M Insert Mail Merge Field
Sh-Ctrl-N Insert Symbol
Sh-Ctrl-X Insert Index Entry
Ctrl-Y Goto Footnote
Sh-Ctrl-Y Insert Footnote

F4 Toggle/Change case of text
F5 Goto Bookmark
F5 Insert Bookmark
F6 Count Words
F7 Spell Check
F8 Thesaurus
F9 Toggle Full Page/Normal View

 




